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1 Introduction

This Manual contains information about the CMT Network Analgz remote
control and its data communication, carried out by means of user program
through a computer network.

This manual describes the analyzer command system and the network protocols

used to deliver commands. The commands sent to the analyzer and the
responses from it are text messages conforming to the SCPI (Standard
Commands forProgrammable Instruments) specification. The text messages are
delivered overcomputer networks using TCP/IP Socket network protocols.

TCP/IP Socketis a generalpurpose netwak protocol. The user program can
connect to the analyzer using the TCP/IP Socket protocol both directly and
through the VISA library.

VISA (Virtual Instrument Software Architecture) is a widely used software
inputoutput interface in the field of testing and measurement for controlling
devicesfrom a personal computer. It is a library of functions for C / C ++, C #,
Visual BasicMATLAB, LabVIEW and others. The VISA library unifies access to all
measuring instruments, regardless of the protocol and equipmenused. The
VISA library isinstalled on the client side, that is, on the computer where the
user program isexecuted. The VISA library is available on the websites of many
companies for free

1.1 Programming Manual Scope

This Manual directly applies to the Panar ¢ TR1300/1, TR5048 and TR7530
models Network Analyzer.

1.2 Related Documents

Before reading this Manual, familiarize yourself with Analyzer Operating
Manual.

1.3 References

IEEE Standard 488£1992, IEEE Standard Codes, Formats, Protocols and
Common Commanddor Use with ANSI/IEEE Std 488¢11987. IEEE, New York,
NY, 1992.

SCPI Standarel1999, Standard Commands for Programmable Instruments
Volume 1: Syntax and Style. SCPI Consortium, San Diego, CA, 1999.

VISA specificationshttp://www.ivifoundation.org/speciations

11



2 Analyzer Interfaces

2.1 Ethernet Interface
Ethernet interface is part of the equipment of a personal computer that
connects to the device"Planar TR1 300/ 1», «TR5048» or

Data transfer between the PC user and the computer that is connectetd the
device, is performed viaSocketprotocol (TCP, port 5025.

Connect the device to a PC in the local Ethernet network of your company.

Activate the function of remote control via Socketprotocol on your Analyzer as
described below.

To enable/disabke remote control via network Socketprotocol, use the following
softkeys:System > Misc Setup > Network Setup PCPSocket ON/OFF.

System Misc Setup ‘ Network Setup

TCP Socket
OFF

025

Port ‘

12
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3 SCPI Overview

The Ethernet interface implement same set of commands based on 1999 SCPI
standard (Standard Commarsl for Programmable Instruments). This command
set allows the exchange of character messages.

SCPI is developed by SCPI Consortium (hitpyww.scpiconsortium.org).The
main features of SCPI standard are described below. For a more detailed
information on SCR standard, see the website of SCPI Consortium.

3.1 Command Tree

The SCPI commands are organized in a tree structure. For example:

/HE:ASure SYSTem
VOLTage RESistance® CURRent Local REMote
DC? AC? DC? AC?

Each tree structure forms a functional system. The base of the tree is called root,
e.g. MEASure and SYSTem. Each functiorgistem can have subsystems of
lower level. The final nodes are called leaves. The entire sequence from root to
the leaf makes up the command. For example, part of SOURCe functional system
looks as follows:

:SOURCce
:POWer

:CENTer

:STARt

:SPAN

:STOP

[[LEVel]

:SLOPe

[:DATA]
:STATe

13



SCPI Overview

This SOURce branch has several levels, whereCENTer, STARt, SPAN,
STOP, DATA, STATe are the leaves, which represent the following six
commands:

:SOURce:POWer:CENTer
:SOURce:POWer:STARt
:SOURce:POWer:SPAN
:SOURce:POWer:STOP
:SOURce:POWer[:LEVel]:SLOPe[:DATA]
:SOURce:POWer[:LEVel]:SLOPe:STATe

The tree can contain subsystems and leaves with the same names if they belong
to different branches, e.gCENTer leaf is on the tips of different branches:

:SOURce :SENSe
:POWer :FREQuency
:CENTer :CENTer

3.2 Subsystems

A colon (%) separates the subsystems. The subsystems, which follow the colon
are of a lower level. For example, in command:

:SOURce:POWer:STARt

the start power STARt is a part of POWersubsystem, which is a part oSOURce
subsystem. The stop power is also a part alSOURce:POWer subsystem. It is
specified by:

:SOURce:POWer:STOP
The first colon in the line can be omitted, for example:
SOURce POWer STOP

3.3 Optional Subg/stems

Some subsystems can be specified as optional, if omission of such a subsystem
will not lead to ambiguity. This means that the subsystem can be omitted in
command line. The optional subsystems are bracketed[["). For example, if full
command speciication is written as:

SOURce:POWer[:LEVel]:SLOPe[:DATA]

subsystemsLEVel and DATAare optional. Therefore the both commands are
valid:

SOURce:POWer:LEVel:SLOPe:DATA
SOURce:POWer:SLOPe

14



SCPI Overview

3.4 Long and Short Formats

Each keyword in a command specification has ahg format and a short format.
The short format of a command is indicated by capital letters. For example, a
command specification:

SENSe:FREQuency:CENTer
can be written as:

SENS:FREQ:CENT

SENS:FREQ:CENTer

Only long or short form of each keyword is acceptale. For example, the
following specification is incorrect:

‘SENS:FREQuen:CEN

3.5 Case Sensitivity

The commands are not case sensitive. Upper case and lower case letters are
only used to indicate the long and short formats of a command specification.
For examge, the following commands are equivalent:

SENS:FREQ:STAR
sens:freq:star

3.6 Parameters

The commands can have parameters. The parameters are separated from the
command by a space. If a command has several parameters, they are separated
by commas ().

3.6.1Numeric Values

The numeric values are integer or real nhumbers. These parameters can have
measurement units. For example:

SENS:FREQ 1000000000
SENS:FREQ 1000 MHz
SENS:FREQ 1 GHz
SENS:FREQ 1E9

15



SCPI Overview

3.6.1.1Multiplier Prefixes

The SCPI standard allows specification of the numie values with multiplier
prefix to the measurement units.

Prefix Multiplier
A lei 18
= lei 15
P lei 12
N lei 9
U 1816
M lei 3
K le3d
MA le6

G 1le9

T lel2
PE lel5
EX 1lel8

There are two exceptions to the above designationprefix M in combination
with HZ or OHM means 1e6 (Mega), and not &8 (milli), i.e. MHZ means
Megahertz, same as MAHZ.

3.6.1.2Notations

The SCPI standard allows numeric value specification in different notations.
Decimal notation is used by default. To use othenotations, specify the numeric
values in the following way:

Notation Prefix Example

Binary #B #B11001010 =202 ,,
Octal #Q #Q107 =71 4,
Hexadecimal #H #H10FF =4351 |,
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SCPI Overview

3.6.2Booleans

The booleans can assume two values: logicalesand logical no (ON and OFF),
and specified in command as:

ONor 1 ¢ logical yes
OFFor 0 ¢ logical no

For example:
DISPlay:ENABIe OFF
DISPlay:ENABIle 0

3.6.3Character Data

The SCPI standard allows specification of parameters as character data, as in the
following command:

TRIGger:SOURCce {BUS|IMMediate|EXTernal}
the possible values of the character data "BUS", "IMMediate", "EXTernal".

The character data have long and short format, and the formats are specified in
accordance with the same rules as described in Sectidh4.

Apart from that, the character data can be combined with numerical parameters.
For example:

SENSe:FREQuency:STARt {MINimum|MAXimum|<value>}
The following specifications are acceptable:
SENSe:FREQuency:STARt MIN
SENSe:FREQuency:STARt maximum
SENSe:FREQuency:STARt 1000000

3.6.4String Parameters

In some cases, the instrument can accept parameters made of character strings.
Such strings are enclosed with single quotes') or double quotes (). For
example, the file name in the state saving ommand:

MMEMory:STORe "state0O1.sta"

3.6.5Numeric Lists

The numeric lists (<numeric list>) are used to specify a variable number of
numerical parameters, for example:

CALC:LIMit:DATA 2,1,1E9,3E9,0,0,2,1E9,3E9, 13,13
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3.7 Query Commands

The query commands read out thgparameter values from the instrument. After a
guery command has been sent, the response should return via remote control
interface.

The query commands has a question mark?) in the end of the command. Many
of the commands have two forms. The form witha question mark writes the
parameter, the form without a question mark reads out the parameter. For
expample:

SENSe:FREQuency:STARt 1 MHz

SENSe:FREQuency:STARt?

3.8 Numeric Suffixes

The instrument contains several items of the same type, such as 9 channels,
each of which in turn contains 8 traces, etc. A numeric suffix is used to denote

the item number in a command. The suffix is added to the keyword of the item

(channel, trace, etc). For expample, in the following specification the channel

number <Ch> and trae number <Tr> indicate the channel and trace, to which

this command is addressed:

CALCulate<Ch>:PARameter<Tr>:DEFine

According to this specification, the command referred to the trace 2 of the
channel 1 will be written as follows:

CALC1:PAR2:DEF

The numercc suffix can be omitted. In this case, it is 1 by default. For example,
the following commands are equivalent:

CALC:PAR:DEF
CALC1:PAR1:DEF

3.9 Compound Commands

It is possible to enter more than one command in the same command line. The
commands in the line ae separated by a semicolon {). The specification of the
first command is valid for the following command, except for the last leaf
before the semicolon. For expample:

SENS:FREQ:STAR 1 MHZ;STOP 2MHZ

If you need to start the next command from the highestlevel of the structure,
this command should start from a colon ¢):

SENS:FREQ:STAR 1 MHZ;:CALC:PAR:DEF S21

18
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3.10IEEE488.2 Common Commands Overview

A SCPI compatible instrument must support a set of common commands of
IEEE488.2 standard. These commands stavith an asterix (*'). The list of such
commands see below:

*CLS

*ESE

*ESE?

*ESR?

*IDN?

*OPC

*OPC?

*RST

*SRE

*SRE?

*STB?

*TRG

*WAI

These commands are used for resetting, state queries, etc.

3.11 String Terminator

The <new line> character (ASCIIQ) in the last data byte of the command string
is used as a command terminator. The string of instructions sent to the
instrument is executed after the instruction terminator is received.

19



4 Remote Control Commands

4.1 Conventions

The following conventions areused throughout the Manual.

4.1.1Syntax

The following symbols are used in command syntax:

<> identifiers enclosed in angular brackets indicated that a
particular type of data must be specified

[] part enclosed in square brackets can be omitted

{} part enclosed in curly brackets indicates that you must select
one of the items in this part. Individual items are separated by a
vertical bar "|"

Space space separates commands from parameters

: comma separates adjacent parameters

h ellipses indicates that parameterdn that part are omitted

20



4.1.2ldentifiers

Remote Control Commands

Identifier Parameter | Description

<numeric> Number {<integer>|<real>}

<frequency > Frequency | <numeric >{[HZ]|KHZ|MHZ|GHZ}

<power > Power ;ll\ﬁl\L;?eric >{[DBM]|DBMW|DBW|KW|W|MW|UW]|
<time > Time <numeric >{[S]|MS|US|NS|PS| FS}

<logmag > Am:ﬁ?ude <numeric >[DB]

<phase > Phase <numeric >{[DEG]|MADEG|KDEG|MDEG|UDEG}
<stimulus> Stimulus {< frequency >|< power >|<time>}

<response> Response | {<logmag >|< phase >|<time>}

E;umfric Numeric List | <numeric 1>,<numeric 2>,...<numeric N>
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Remote Control Commands

4.2 [IEEE488.2 Common Commands

*CLS
*CLS
Clears the following (no query)
Uy Error Queue
y Status Byte Register
Descrintion y Standard Event Status Regi st
P y Operation Status Event Regi s
Uy Questionable Status Event Re
Uy QuestionablventRepgistert St atus E
Uy Questionable Limit Channel S
Target Status Reporting System
Equivalent
Softkeys None
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*ESE

*ESE <numeric>

*ESE?
_ Sets or reads out the value of the Standard Event Status Enable
Description .
Register (command/query).
Target Status Reporting System
Parameter <numeric>0 to 255

Out of Range

Bitwise AND with 255 number

Query Responsg¢ <numeric>
Preset Value |0
Equivalent
Softkeys None

*ESR

*ESR?

- Reads out the value of the Standard Event Status Register.

Description . . .
Executing this command clears the register value (query only).

Target Status Reporting System
Query Respons{ <numeric>
Equivalent
Softkeys None
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Renote Control Commands

*IDN?
*IDN?

Reads out the instrument information string. The string format:
<manufacturer>, <modet, <serial number>, <software

Description version/firmware version> (query only).
For example: Copper Mountain Technologies, Planar TR1300/1,
00000101, 0.8.12/1.0

Target Instrument

Query Responst

String up to 40 characters

Equivalent

Softkeys None
*OPC

*OPC

Desriotion Sets the OPC bit (bit 0) of the Standard Event Status Register at thq
P completion of all pending operations (no query).

Target Status Reporting System

Equivalent

Softkeys None
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*OP@
*OPC?
Description ir:lsy)read out at the completion of all pending operations (query
Target Status Reporting System

Query Respons¢ 1

Equivalent
Softkeys None
*RST
*RST

Restores the default settings of the instrument (no query).

Description There is difference from presetting the instrument with
:SYST:PRES commande in this case the trigger mode is set to
Hold

Target Instrument

Related SYSTem:PRESet

Commands

Equivalent

Softkeys None
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Remote Control Commands

*SRE

*SRE <numeric>

*SRE?
- Sets or reads out the value of the Service Request Enable Register
Description
(command/query)
Target Status Reporting System
Parameter <numeric> 0 to 255.

Out of Range | Bitwise AND with 255 number

Query Responsg¢ <numeric>

Preset Value 0

Equivalent
Softkeys None
*STB?
*STB?
Description Reads out the value of the Status Byte Register (quennly).
Target Status Reporting System

Query Responsg¢ <numeric>

Equivalent

Softkeys None
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*TRG
*TRG
If the trigger source is set to LAN (set to BUS with theTRIG:SOUR
command), triggers a sweep.
Description If the trigger source is not set to the bus o the instrument is not
P waiting for a trigger, the command is ignored.
The command is completed before the end of the sweep.
(no query)
Target Instrument
Related TRIG:SOUR
Commands
Equivalent
Softkeys None
*WAI
*WAI
- Waits for the executionof all commands sent before this command.
Description (no query)
Target Instrument
Equivalent
Softkeys None
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4.3 Network Analyzer Commands

ABOR
ABORt
Aborts the sweep and switches the triggers of all the channels to
Hold The channels inContinuoudrigger mode switch to waiting for
Description a trigger. If the trigger source is set to Internal, the channel from
waiting for a trigger turns to a new sweep.
(no query)
Equivalent
Softkeys None
CALCCONV

CALCulate<Ch>[:SELected]:CONVersion[:STATe] {ON|OFF|1|0}

CALCulate <Ch>[:SELected]:CONVersion [[STATe] ?

Sets or reads out the ON/OFF state ofeparameter conversion

D ipti .
escription function (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8]|9}
{ON]1} Se parameter conversion function ON
Parameter

{OFF|0}  Separameter conversion function OFF

Query Respons

{011}

Preset Value

0

Equivalent
Softkeys

Analysis > Conversion > Conversion
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Remote Catrol Commands

CALC:CONV:FUNC

CALCulate<Ch>[:SELected]:CONVersion:FUNCtion <char>

CALCulate <Ch>[:SELected]:CONVersion:FUNCtion?

Sets or reads out the §parameter conversion function type

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3/4|5|6|7|8|9}
<char> specifies parameter
IMPedance : Equivalent transmission or reflection
impedance, depending on the parameter S11 or
S21
Parameter ADMittance : Equivalent transmission or reflection
conductance, depending on the parameter S11 or
S21
INVersion . Inverse & parameter
CONJugation : Se parameter conjugate

Out of Range

Error occurs. The commahis ignored.

Query Responst

{IMP|ADM]|INV|CONJ}

Preset Value

IMP

Equivalent
Softkeys

Analysis > Conversion #unction{ Impedance Z | Admittance Y |
Inverse 1/S | Conjugation }
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Remote Control Commands

CALC:CORR:EDEL:TIME
CALCulate<Ch>[:SELected]:CORRection:EDELay:TIME <time >

CALCulate<Ch>[:SELected]:CORRection:EDELay:TIME?

Description Sets or reads out the value of the electrical delay (command/query)

The active trace of channel <Ch>,

Target <Ch>={[1]|2/3]4/5/67/8]9}
Parameter <time> the electrical delay value frome 10 to 10
Unit s (second)

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>

Preset Value 0

Equivalent

Softkeys Scale > Electrical Delay
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Remote Control Commands

CALC:CORR:OFFS:PHAS

CALCulate<Ch>[:SELected]:CORRection:OFFSe t:PHASe <phase>

CALCulate<Ch>[:SELected]:CORRection:OFFSet:PHASe?

Description Sets or reads out the value of the phase offset (command/query).
Target The aftive trace of channel <Ch>,
<Ch>={[1]|2|3]4[5|6]7|8|9}
Parameter <phase> the phase offset value fom € 360 to 360
Unit ° (degree)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Scale > Phase Offset
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Remote Control Commands

CALC:DATA:FDAT?

CALCulate<Ch>[:SELected]:DATA:FDATa?

Reads out the formatted data array (query only).

The formatted data array is the data, whose processing is complete
including the formatting as the last step. Such data represent the
data trace values as they are shown on the screen.

The array sze is 2N, where N is the number of measurement points,
For the re th point, where n from 1 to N:

Description
<numeric 2n 71> real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The active trace of channel <Ch>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

Related CALC:FORM
Commands FORM:DARA
Equivalent

Softkeys None
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CALC:DATA:FMEM?

CALCulate<Ch>[:SELected]:DATA:FMEMory?

Reads out the formatted memory array (query only).

The formatted memory array is the data, whose processing is
completed including the formatting as the last 4ep. Such data
represent the memory trace values as they are shown on the screel
The array size is 2N, where N is the number of measurement pointg
For the re th point, where n from 1 to N:

Description
<numeric 2n 11> real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The active trace of channel <Ch>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The datatransfer format depends on theFORM:DATAcommand
setting.

If the memory is empty, an error occurs and the command is

Notes :
ignored.
Related CALC:MATH:MEM
CALC:FORM
Commands FORM:DATA
Equivalent
Softkeys None
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CALC:DATA:SDAT?

CALCulate<Ch>[:SELected]:D ATA:SDATa?

Reads out the corrected data array (query only).

The corrected data array is the data, whose processing is complete
excluding the formatting as the last step. Such data representsS
parameter complex values.

The array size is 2N, whee N is the number of measurement points.

Description _
For the re th point, where n from 1 to N:
<numeric 2n 71> the real part of corrected measurement;
<numeric 2n> the imaginary part of corrected measurement
Target The active trace of channel <Ch>,

<Ch>={[1]|23]  4/5/6|7|8]9}

Query Responst

<pumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cFORM:DATAcommand
setting.

Related

FORM:DATA
Commands
Equivalent
Softkeys None
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CALC:DATA:SMEM?

CALCulate<Ch>[:SELected]:DATA:SMEMory?

Reads out the corrected memory array (query only).

The corrected memory array is the data, whose processing is
completed excluding the formatting as the last step. Such data
represent & parameter complex values.

The array size is 2N, where N is the nuber of measurement points.
For the re th point, where n from 1 to N:

Descripton
<numeric 2n 71> the real part of corrected measurement
memory;
<numeric 2n> the imaginary part of corrected measurement
memory.
The active trace of channel <Ch>,
Target

<Ch>={[1]|2]3  |4/5|6|7|8|9}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

If the memory is empty, an error occurs and the command is

Notes .

ignored.
Related CALC:MATH:MEM
Commands FORM:DATA
Equivalent
Softkeys None

35




Remote Control Commands

CALC:FILT:TIME

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME[:TYPE] <char>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME[:TYPE]?

Sets or reads out the gate type of the gating function

Description (command/query).

Target The aftivetrace of channel <Ch>,
<Ch>={[1]|2|3|4|5]6|7|8|9}
<char> specifies the gate type:

Parameter BPASs :Bandpass type

NOTCh : Notch type

Out of Range

Error occurs. The command is ignored.

Query Responst

{BPAS|NOTC}

Preset Value

BPAS

Equivalent

Softleys

Analysis > Gating > Type
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CALC:FILT:TIME:CENT

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:CENTer <time>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:CENTer?

Sets or reads out the gate center value of the gating function

Description (command/query).
Taroet The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the center value of the gate, the range varies depending or
Parameter .
the frequency span and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, which iscloser to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Analysis > Gating > Center
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CALC:FILTIMESHAP

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:SHAPe <char>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:SHAPe?

Desciption

Sets or reads out the gate shape of the gating function
(command/query).

Target

The active trace of channel <Ch>,
<Ch>={[1]|2/3|4|5/6/7|8]9}

Parameter

<char> specifies the gate shape:
MAXimum : Maximum shape
WIDE : Wide shape
NORMal : Norma shape

MINimum : Minimum shape

Out of Range

Error occurs. The command is ignored.

Query Responst

{MAX|WIDE|NORM]|MIN}

Preset Value

NORM

Equivalent
Softkeys

Analysis > Gating > Shape > { Maximum | Wide | Normal | Minimum
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CALCEILT-TIME:SPAN

CALCUate<Ch>[:SELected]:FILTer[:GATE]:TIME:SPAN <time>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:SPAN?

Sets or reads out the gate span value of the gating function

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8 19}
<time> the span value of the gate, the range varies depending on
Parameter )
the frequency span and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>
Prese Value 2ei 8
Equivalent . :
> >
Softkeys Analysis > Gating > Span
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CALC:FILTIMESTAR

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:STARt <time>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:STARt?

Sets or reads out the gate start value of the gating faction

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2]3]4/5|6|7|8|9}
<time> the start value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)

Out of Range

Sets the vdue of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

11ei 8

Equivalent
Softkeys

Analysis > Gating > Start
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CALC:FILT:TIME:STAT

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:STATe {ON|OFF|1|0}

CALCulate<Ch>[:SELec ted]:FILTer[:GATE]:TIME:STATe?

Sets or reads out the ON/OFF state of the gating function

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON]1} Gating function ON
Parameter

{OFF|0}  Gating function OFF

Query Responsg {0|1}
Preset Value 0
Equivalent _ _ _
> >
Softkeys Analysis > Gating > Gating
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CALC:FILTIMESTOP

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:STOP <time>

CALCulate<Ch>[:SELected]:FILTer[:GATE]:TIME:STOP?

Sets or reads out the gate stopralue of the gating function

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the stop value of the gate, the range varies depending on
Parameter .
the frequency span and the number of points
Unit s (second)

Outof Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

+1ei 8

Equivalent
Softkeys

Analysis > Gating > Stop
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CALC:FORM

CALCulate<Ch>[:SELected]:FORMat

Remote Control Commands

{ <char>

CALCulate<Ch>[:SELected]:FORMat?

Description Sets or reads out the trace format (command/query).
<char> specifies the trace format:
MLOGarithmic  : Logarithmic magnitude
PHASe : Phase
GDELay : Group delaytime
SLINear : Smith chart format (Lin)
SLOGarithmic : Smith chart format(Log)
SCOMplex : Smith chart format (Real/Imag)
SMITh : Smith chart format (R + jX)
Parameter SADMittance : Smith chart format (G + jB)
PLINear : Polar format (Lin)
PLOGarithmic : Polar format (Log)
POLar : Polar format (Real/Imag)
MLINear : Linear magnitude
SWR : Voltage standing wave ratio
REAL : Real part
IMAGinary : Imaginary part
UPHase : Expanded phase

Out of Range

Error occurs. The command is ignored.

QueryResponse

{MLOG|PHAS|GDEL|SLIN|SLOG|SCOM|SMIT|SADM|PLIN|
PLOG POL|MLIN|SWR|REAL|IMAG|UPH}

Preset Value

MLOG

Equivalent
Softkeys

Response> Format > {Log Mag | Phase | Group Delay | Lin Mag |
SWR | Real | Imag | Phase Exp }

Response> Format >Smith > {Log/Phase | Lin/Phase | Real/Imag |

R+jX| G+jB }

Response> Format >Polar > { Log/Phase | Ling/Phase | Real/lmag }
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Remote Contol Commands

CALC:FSIM:SEND:DEEM:PORT:STAT

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed:PORT<Pt>:STATe

{ON|OFF|1|0}

CALCulate<Ch>:FSIMulator:SENDed:DEEMb ed:PORT<Pt>:STATe?

Sets or reads out the ON/OFF state of the deembedding function

Description (command/query).

Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}

<Pt>=([1]j2}

{ON|1} Dee embedding function ON
Parameter

{OFF|0}  Dee embedding function OFF

Query Responst

{0]1}

Preset Value

0

Equivalent
Softkeys

Analysis > Fixture Simulator > De Embedding > Port n
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CALC:FSIM:SEND:DEEM:PORT:USER:FIL

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed:PORT<Pt>:USER:FILename

<string>

CALCulate<Ch>:FSIMulator:S ENDed:DEEMbed:PORT<Pt>:USER:FILename

?

Description

Sets or reads out the name of *.s2p file of the deembedded circuit
of the dee embedding function (command/query). The file contains
the circuit Se parameters in Touchstone format.

Target

Port <Pt> of channé<Ch>,
<Ch>={[1]|2|3|4|5]6|7|8|9}
<Pt>={[1]|2}

Parameter

<srting>, up to 256 characters(quoted string)

Preset Value

un

If the full path of the file is not specified, the \FixtireSim

Notes subdirectory of the main directory will be searched for the fie.
Equivalent Analysis > Fixture Simulator > DeEmbedding > $ parameters File
Softkeys
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CALC:FSIM:SEND:PMC:PORT:STAT

CALCulate<Ch>:FSIMulator:SENDed:DEEMbed:PORT<Pt>:STATe

{ON|OFF|1|0}

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit:PORT<Pt>:STATe?

Sets or reads out the ON/OFF state of the embedding function

Description (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>=([1]j2}
{ON]1} Embedding function ON
Parameter

{OFF|0} Embedding function OFF

Query Responsq {0|1}

Presetvalue 0

Equivalent Analysis > Fixture Simulator > Embedding > Port n
Softkeys
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CALC:FSIM:SEND:PMC:PORT:USER:FIL

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit:PORT<Pt>:USER:
FlLename <string>

CALCulate<Ch>:FSIMulator:SENDed:PMCircuit:PORT<Pt>:USER:
FilLename?

Sets or reads out the name of *.s2p file of the embedded circuit of
Description the embedding function (command/query). The file contains the
circuit Se parameters in Touchstone format.

Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2]3]4|5|6|7]8|9}
<Pt>={[1 ]2}

Parameter <string>, up to 256 characters(quoted string)

Preset Value

If the full path of the file is not specified, the \FixtireSim

Notes subdirectory of the main directory will be searched for the file.
Equivalent Analysis > FixtureSimulator > Embedding >User File
Softkeys
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CALC:FSIM:SEND:ZCON:PORT:Z0

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:PORT<Pt>:Z0[:R]
<impedance>

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:PORT<Pt>:Z0[:R]?

Sets or reads out the value of the impedance foport impedance

Description . .
P conversion function (command/query).

Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5]|6|7|8|9}
<Pt>=([1][2}

Parameter <impedance> the impedance value from 1e 6 to 1e6

Unit w ( Ohm)

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons¢ <numeric>

Preset Value 50

Equivalent

Analysis > Fixture Simulator > Port Z Conversion > Port n Z0
Softkeys
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CALC:FSIM:SEND:ZCON:STAT

CALCulate<Ch >:FSIMulator:SENDed:ZCONversion:STATe {ON|OFF|1|0}

CALCulate<Ch>:FSIMulator:SENDed:ZCONversion:STATe?

Sets or reads out the ON/OFF state of the port impedance

Description conversion function (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
{ON]1} Port Z conversion function ON
Parameter

{OFF|0} Port Z conversion function OFF

Query Respons¢ {0[1}

Preset Value |0

Equivalent Analysis > Fixture Simulator > Port Z Conversion > Port Z Conversi
Softkeys
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CALC:FUNC:DATA?

CALCulate<Ch>[:SELec ted]:FUNCtion:DATA?

Reads out the data array, which is th€ALC:FUNC:EXECcommand
analysis result (query only).

The array size is 2N, where N is the number of points set by
CALC:FUNC:POIN? command.

For the re th point, where n from 1 to N:

Description <numeric 2n 71>  the response value in 18 th measurement
point;
<numeric 2n> the stimulus value in ne th measurement
point. Always set to O for the analysis of
mean value, standard deviation, and peak
toe peak value.
i <Ch>
Target The active trace of channel <Ch>,

<Ch>={[1]2|3]4/5|6]7|8|9}

Query Responst

<pumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

CALC:FUNC:EXEC

Related CALC:FUNC:POIN?
Commands FORM:DATA
Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:DOM

CALCuate<Ch>[:SELected]:FUNCtion:DOMain[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:FUNCtion:DOMain[:STATe]?

Sets or reads out the ON/OFF state of an arbitrary range use in

Description | A c:FUNC:EXECcommand (command/query).
All traces of channel <®@> (if the coupling is set to ON by the
Target CALC:FUNC:DOM:COURommand), the active trace of channel
<Ch> (if otherwise),
<Ch>={[1]|2|3|4|5|6|7|8|9}
{ON]1} Arbitrary range ON
Parameter

{OFF|0}  Arbitrary range OFF (entire sweep range)

Query Responst

{0]1}

Preset Value

0

Related CALC:FUNC:EXEC
Commands CALC:FUNC:DOM:COUP
Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:DOM:COUP

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:COUPIle {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:COUPIle?

Sets or reads out he ON/OFF state of trace coupling for analysis

Description range of the CALC:FUNC:EXECcommand (command/query).
Target All traces of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON|1} coupling ON
Parameter

{OFF|0}  coupling OFF

Query Respons¢ {0[1}

Preset Value 1

Related CALC:FUNC:EXEC
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:DOM:STAR

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:STARt <stimulus>

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:STARt?

Sets the start value of the analysis range of theCALC:FUNCEXEC

Description command (command/query).
All traces of channel <Ch> (if the coupling is set to ON by the
Target CALC:FUNC:DOM:COURommand), the active trace of channel
<Ch> (if otherwise),
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <stimulus> the start value of analysk range
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Query Responst

<numeric>

Preset Value

Related CALC:FUNC:DOM
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:DOM:STOP

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:STOP <stimulus>

CALCulate<Ch>[:SELected]:FUNCtion:DOMain:STOP?

Sets the stop value of the analysis range of th€ALC:FUNC:EXEC

Description command (command/query).
All traces of channel <Ch> (if the coupling is set to ON by the
Target CALC:FUNC:DOM:COURommand), the adtve trace of channel
<Ch> (if otherwise),
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <stimulus> the stop value of analysis range
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Query Responst

<numeric>

Preset Value

Related CALC:FUNC:DOM
Commands

Equivalent

Softkeys None

54




Remote Control Commands

CALC:FUNC:EXEC

CALCulate<Ch>[:SELected]:FUNCtion:EXECute

Executes the analysis specified by th€ ALC:FUNC:TYPE
command.

Description The analysis result can be read out by th€ ALC:FUNC:DATA?
command.

(no query)

The active trace of channel <Ch>,

Tamet <Ch>={[1]|2|3|4|5|6|7|8|9}

Related CALC:FUNC:TYPE
Commands CALC:FUNC:DATA?

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:PEXC

CALCulate<Ch>[:SELected]:FUNCtion:PEXCursion <response>

CALCulate<Ch>[:SELected]:FUNCtion:PEXCursio n?

Sets the lower limit for the peak excursion value when executing

Description the peak search with theCALC:FUNC:EXECcommand
(command/query).
The active trace of channel <Ch>,
Target <Ch>={[1]|2|3|45|6/7|8]9}
<response> the lower limit of t he peak excursion value, varies
Parameter .
depending on the data format
Unit { dB (decibel) | ° (degree) |
Query Respons¢ <numeric>
Preset Value 3

Related CALC:FUNC:EXEC
Commands

Equivalent

Softkeys None

56




Remote Control Commands

CALC:FUNC:POIN?

CALCulate<Ch>[:SELected]:FU NCtion:POINts?

Reads out the number of points (data pairs) of the analysis result by
the CALC:FUNC:EXECcommand (query only).
Always reads out 1, when the search is executed for the maximum,

Description . L
P minimum, mean, standard deviation, peak, and peakoe peak
values. The actual number of points is read out, when the search is
executed for all peak or all targets.
The active trace of channel <Ch>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<numeric>

Related CALC:FUNC:EXEC
Commands

Equivalent

Softleys None
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Remote Control Commands

CALC:FUNC:PPOL

CALCulate<Ch>[:SELected]:FUNCtion:PPOLarity <char>

CALCulate<Ch>[:SELected]:FUNCtion:PPOLarity?

Selects the polarity when performing the peak search with the

Description | - a| ¢:FUNC:EXECcommand (command/query).
Target The active frace of channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}
<char> specifies the polarity:
POSitive : Positive peaks
Parameter

NEGative : Negative peaks

BOTH : Both positive peaks and negative peaks

Out of Range

The command is ignored.

Query Responst

{POS|N EG|BOTH}

Preset Value | POS

Related CALC:FUNC:EXEC
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:TARG

CALCulate<Ch>[:SELected]:FUNCtion:TARGet <response>

CALCulate<Ch>[:SELected]:FUNCtion:TARGet?

Selects the target level when performing the sarch for the trace

Description and the target level crosspoints with the CALC:FUNC:EXEC
command (command/query).

Parameter <response> the target value, varies depending on the data format

Unit {dB (decibel) | ° (degree) | s

Query Respons{ <numeric>

Preset Value 0

Related CALC:FUNC:EXEC
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:TTR

CALCulate<Ch>[:SELected]:FUNCtion: TTRansition <char>

CALCulate<Ch>[:SELected]:FUNCtion: TTRansition?

Description

Selects the transition type when performing the search for the trace
and the target level crosspoints with the CALC:FUNC:EXEC
command (command/query).

Target

The active trace of channel <Ch>,
<Ch>={[1]|2|3|4]5|6]7|8|9}

Parameter

<char> specffies the type of transition:
POSitive : Positive peaks
NEGative : Negative peaks

BOTH : Both positive peaks and negative peaks

Out of Range

The command is ignored.

Query Responst

{POS|NEG|BOTH}

Preset Value POS

Related CALC:FUNC:EXEC
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:FUNC:TYPE
CALCulate<Ch>[:SELected]:FUNCtion: TYPE <char>

CALCulate<Ch>[:SELected]:FUNCtion:TYPE?

Description Selects the type of analysis executed with theCALC:FUNC:EXEC
command (command/query).
Target The aftive trace of clannel <Ch>,
<Ch>={[1]|2|3]4]5|6|7|8|9}
<char> specifies the transition:
PTPeak : Peale toe peak (difference between the maximum
value and the minimum value)
STDEV : Standard deviation
MEAN : Mean value
Parameter MAXimum : Maximum value
MINimum : Minimum value
PEAK : Search for peak
APEak : Search for all the peaks
ATARget : Search for all targets
Out of Range | The command is ignored.
Query Respons¢ {PTP|STDEV|MEAN|MAX|MIN|PEAK|APE|ATAR}
Preset Value PTP
Ei'ritr‘;‘;n o | CALCFUNCEXEC
St e
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CALC:LIM
CALCulate<Ch>[:SELected]:LIMIit[:STATe] {ON|OFF|1]0}

CALCulate<Ch>[:SELected]:LIMIit[:STATe]?

Remote Control Commands

Sets or reads out the ON/OFF state of the limit test function

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|12|]3  |4/5|6|7|8|9}
{ON]1} Limit test function ON
Parameter

{OFF|0}  Limit test function OFF

Query Responsg¢ {0]1}

Preset Value 0

Equivalent

1 > H M > . .
Softkeys Analysis > Limit Test > Limit Test
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Remote Control Commands

CALC:LIM:DATA

CALCulate<Ch>[:SELected]:LIMit:DATA <numeric list>

CALCul ate<Ch>[:SELected]:LIMit:DATA?

Sets the data array, which is the limit line in the limit test function

(command/query).

The array size is 1 + 5N, where N is the number of limit line

segments.

For the re th point, where n from 1 to N:

<numeric 1> the number of limit line segments N is from
0 to 100. Setting O clears the limit line.

<numeric5n 13> type of the neth limit line segment
1 0: Off.
1 1: Upper limit

Description 1 2: Lower limit

1 3: Single Poaint limit

<numeric 5n 72>  the stimulus value in the start pant of the
ne th segment

<numeric 5n 71>  the stimulus value in the end point of the
ne th segment

<numeric 5n 710>  the response value in the start point of the
ne th segment

<numeric 5n+1> the response value in the end point of the
ne th segment

The active trace of channel <Ch>,

Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Respons

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

If the array size is not 1 + 5N, where N isnumeric 1> , an error
occurs If <numeric 5n T 3> is less than 0 or more than 2an error
occurs When<numeric 5n 12>, <numeric 5n 11>,

Notes
<numeric 5n T 0>, and<numeric 5n+1> elements are out of
allowable range, the value is set to the limit, which is closer to the
specified value.

Related FORM:DATA

Commands

Equivalent . - o
Analysis > Limit Test > Edit Limit Line

Softkeys
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Remote Control Commands

CALC:LIM:DISP

CALCulate<Ch>[:SELected]:LIMit:DISPlay[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected]:LIMit:DISPlay[:STATe]?

Sets or reads out the ON/OFF sta of the limit line display of the

Description limit test function (command/query).
Target The active trace of channel <Ch>,
g <Ch>={[1]|2|3|4|5|6|7|8|9}

{ON]1} Limit line display ON
Parameter

{OFF|0}  Limit line display OFF
Query Responsq {01}
Preset Value 0
Equivalent Analysis > Limit Test > Limit Line
Softkeys y

CALC:LIM:FAIL?

CALCulate<Ch>[:SELected]:LIMit:FAIL?

Description Reads out the limit test result (query only).
Taroet The active trace of channel <Ch>,
9 <Ch>={[1]|2]3|4|5|6|7|8]|9}
1 Fail
Query Responst
0 Pass
Equivalent
Softkeys None
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Remote Control Commands

CALC:LIM:OFFS:AMPL

CALCulate<Ch>[:SELected]:LIMit: OFFSet:AMPLitude <response>

CALCulate<Ch>[:SELected]:LIMit: OFFSet:AMPLitude?

Description

Sets the value of the limit line offset along Y axis

(command/query).
Target The active trace of channel <Ch>,
J <Ch>={[1]|2]3|4/5|6|7|8]9}
<response> the value of the limit line offset along Ye axis, varies
Parameter .
depending on the data format
Unit { dB (decibel) | ° (degree) |
Query Respons¢ <numeric>
Preset Value 0

Equivalent
Softkeys

Analysis > Limit Test > Limit Line Offsets > Response Offset
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Remote Control Commands

CALC:LIM:OFFS:STIM

CALCulate<Ch>[:SELected]:LIMit: OFFSet:STIMulus <stimulus>

CALCulate<Ch>[:SELected]:LIMit: OFFSet:STIMulus?

Description

Sets the value of the limit line offset along Xe axis

(command/query).
Target The aftive trace of channel <Ch>,

<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <stimulus> the value of the limit line offset along X¢ axis
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }
Query Rsponse| <numeric>
Preset Value |0

Equivalent
Softkeys

Analysis > Limit Test > Limit Lines Offsets > Stimulus Offset
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Remote Control Commands

CALC:LIM:REP:ALL?

CALCulate<Ch>[:SELected]:LIMit:REPort:ALL?

Description

Reads out the data array, which is the limit test results (qugronly).
The array size is 4N, where N is the number of measurement pointg
For the re th point, where n from 1 to N:

<numeric 4n 73>  the stimulus value in the ne th point;

<numeric 4n 72>  the limit test result in the n ¢ th point;
M €1:Nolimit
T O: Falil
¥ 1: Pass

<numeric 4n 71>  the upper limit value in the ne th point (0 ¢ if
there is no limit)

<numeric 4n 70>  the lower limit value in the neth point (0 ¢ if
there is no limit)

Target

The active trace of channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Respoms

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

Related FORM:DATA
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:LIM:REP:POIN?

CALCulate<Ch>[:SELected]:LIMit:REPort:POINts?

Reads out thenumber of the measurement points that failed the
limit test (query only).

Description The stimulus data array of these points can be read out by the
CALC:LIM:REP? command.
The active trace of channel <Ch>,

Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Respons¢ <numeric>

Related CALC:LIM:REP?
Commands

Equivalent

Softkeys None
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Remote Control Commands

CALC:LIM:REP?

CALCulate<Ch>[:SELected]:LIMit:REPort[:DATA]?

Reads out the data array, which is the stimulus values of the
Description measurement points that failed the limit test (query only).
The array size is set by theCALC:LIM:REP:POIN? command.

The active trace of channel <Ch>,

Target <Ch>={[1]|2|3]4|5|6|7|8|9}

<pnumeric 1>, <pumeric 2>, é<num

Query Respons The data transfer format depends on th&cORM:DATAcommand

setting.

Related CALC:LIM:REP:POIN?
Commands FORM:DATA

Equivalent

Softkeys None
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Remote Control Commands

CALCMARK

CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe]?

Description

Sets or reads out the ON/OFF state of a marker (command/query).
Turning ON a marker with the number from 1 to 15 will turn ON all
the markers of smaller numbers. Turning OFF a marker with the
number from 1 to 15 will turn OFF all the markers of greater
numbers (except of the reference marker). Turning ON/OFF the
reference marker with number 16 does not turn ON/OFF the
markers with the numbers from 1 to 15, but switchs these markers
to the relative measurement mode.

Target

Marker <Mk> of the active trace of channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3]4|5|6|7|8 [9]10]11|12|13|14|15|16}

Parameter

{ON]1} marker ON

{OFF|0} marker OFF

Query Responst

{0]1}

Preset Value

0

Equivalent
Softkeys

Markers > Add Marker | Remove Marker
Markers > Reference Marker
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Remote Control Commands

CALC:MARK:ACT

CALCulate<Ch>:SELected]:MARKer<Mk>:ACTiv

ate

Description

Sets the active marker (no query).

If the marker is not ON, this function will turn the marker ON.
Turning ON a marker with the number from 1 to 15 will turn ON all
the markers of smaller numbers. Turning ON the reference marker
with number 16 does not turn ON the markers with the numbers
from 1 to 15, but switchs these markers to the relative measuremen
mode.

Target

Marker <Mk> of the active trace of channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3]4|5|6|7|8|9|10]|11]|12|13|14|15|16}

Equivalent
Softkeys

Markers >Active Marker> Marker n
Markers > Reference Marker

CALC:MARK:BWID

CALCulate<Ch>[:SELected]:MARKer:BWIDth[:STATe] {ON|OFF|1]0}

CALCulate<Ch>[:SELected]:MARKer:BWIDth[:STATe]?

Sets or reads out the ON/OFF statefahe bandwidth search

Description function (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
{ON|1} Bandwidth search function ON
Parameter
{OFF|0}  Bandwidth search function OFF
Query Responsg¢ {0|1}
Preset Value 0
Equivalent Markers > Marker Math > Bandwidth Search > Bandwidth Search
Softkeys
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Remote Control Commands

CALC:MARK:BWID:DATA?

CALCulate<Ch>[:SELected]:MARKer<Mk>:BWIDth:DATA?

Reads out the bandwidth search result (query only).

The bandwidth search can performed relatively to te marker <Mk>,
or relatively to the absolute maximum value of the trace (in this
case the number of the marker is ignored), what is set by the
CALC:MARK:BWID:REFcommand.

The data include 4 elements:

Description _
<numeric 1> Bandwidth;
<numeric 2> Center frequency
<numeric 3> Q value;
<numeric 4> Loss;
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8]|9]|10|11|12|13|14|15|16}
Query Respons¢ <numeric 1>, <numeric 2>, e€e<nu
Related CALC:MARK:BWID:REF
Commands
If the bandwidth search is impossible, all the read out values are 0.
Notes If the search is performed relatively to a maker, whicts OFF, an
error occurs.
Equivalent
Softkeys None
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Remote Control Commands

CALC:MARK:BWID:REF

CALCulate<Ch>[:SELected]:MARKer:BWIDth :REFerence <char>

CALCulate<Ch>[:SELected]:MARKer:BWIDth:REFerence?

Description

Selects the reference point for the bandwidth search function:
reference marker or absolute maximum value of the trace
(command/query).

Target

The active trace of channel <Ch>
<Ch>={[1]|2|3|4|5]6|7|8|9}

Parameter

<char> choose from:
MARKer : Bandwidth search relative to the reference marker

MAXimum : Bandwidth search relative to the absolute maximum
of the trace

MINimum : Bandwidth search relative to the absolute nmimum
of the trace

Out of Range

The command is ignored.

Query Responst

{MAX|MARKMIN }

Preset Value

MAX

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Search > Search Ref To
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Remote Control Commands

CALC:MARK:BWID:THR

CALCulate<Ch>[:SELected]:MARKer<Mk>:BWIDth: THReshold

<r esponse>

CALCulate<Ch>[:SELected]:MARKer<Mk>:BWIDth: THReshold?

Description Sets the bandwidth definition value.(command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]|2|3]|4|5]6|7|8|9}
<Mk>={[1]|2|3]4|5|6]7|8|9]|10|11]|12|13|14|15 |16}
<response> the bandwidth definition value, the range varies

Parameter .
depending on the data format

Unit { dB (decibel) | ° (degree) |

Query Respons¢ <numeric>

Preset Value 3

Equivalent
Softkeys

Markers > Marker Math > Bandwidth Seah > Bandwidth Value
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Remote Control Commands

CALC:MARK:BWID:TYPE

CALCulate<Ch>[:SELected]:MARKer:BWIDth:TYPE <char>

CALCulate<Ch>[:SELected]:MARKer:BWIDth:TYPE?

Description Sets the type of the bandwidth search function (command/query).
The active trace of channel <Ch>

Target <Ch>={[1]123/4/56|7|8]9}
<char> specifies the type of the bandwidth:

Parameter BPASSs : Bandpass

NOTCh :Notch

Out of Range

The command is ignored.

Query Responst

{BPAS|NOTC}

Preset Value

BPAS

Equivalent
Softkeys

Markers > Marker Math > Bandwith Search > Type
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Remote Control Commands

CALC:MARK:COUN

CALCulate<Ch>[:SELected]:MARKer:COUNt <numeric>

CALCulate<Ch>[:SELected]:MARKer:COUNt?

Description Sets the number of the turned ON markers (command/query).
Target The active trace of channel <Ch>,

J <Ch>={[1]|2|3]4[5]6]7|8 19}
Parameter <numeric>, range from 0 to 16

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>
Preset Value 0
Equivalent

Non
Softkeys one

CALC:MARK:COUP

CALCulate<Ch>[:SELected]:MARKer:COUPIle {ON|

OFF|1|0}

CALCulate<Ch>[:SELected]:MARKer:COUPIle?

Sets or reads out the ON/OFF state of the marker coupling function

Description (command/query).
Target All the traces of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON]1} Marker coupling ON
Parameter
{OFF| 0}  Marker coupling OFF
Query Respons¢ {0[1}
Preset Value 1

Equivalent
Softkeys

Marker > Properties > Marker Couple
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Remote Control Commands

CALC:MARK:FUNC:DOM

CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain[:STATe]

{ON|OFF|1]0}
CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMai n[:STATe]?
- Sets or reads out the ON/OFF state of the marker search range
Description
(command/query).
All traces of channel <Ch> (if the marker search range coupling is
Target set to ON by theCALC:MARK:FUNC:DOM:COUPommand),
The active trace of channekCh> (if otherwise),
<Ch>={[1]|2|3|4(516]7|8]|9}
{ON|1} Marker search range ON
Parameter

{OFF|0}  Marker search range OFF

Query Responst

{0]1}

Preset Value

0

Equivalent
Softkeys

Markers > Marker Search > Search Range
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Remote Control Commands

CALC:MARK:FUNC:DOM:STAR

CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt

<stimulus>

CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt?

Sets or reads out the start value of the marker search range

Description (command/query).
All traces of channel <Ch> (if the marker seah range coupling is

Target set to ON by theCALC:MARK:FUNC:DOM:COUBommand),
The active trace of channel <Ch> (if otherwise),
<Ch>={[1]|2|3|4|5|6|7|8|9}

Parameter <stimulus> the start value of the marker search

Unit { Hz (Hertz) | s (second) | dBm (decibeddove 1 milliwatt) }

Query Responst

<numeric>

Preset Value

3E5 (Planare TR1300/1)
2E4 (TR5048)
2E4 (TR7530)

Equivalent
Softkeys

Markers > Marker Search > Search Start
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Remote Control Commands

CALC:MARK:FUNC:DOM:STOP

CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP

<stim ulus>

CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP?

Sets or reads out the stop value of the marker search range

Description (command/query).
All traces of channel <Ch> (if the marker search range coupling is
Target set to ON by theCALC:MARK:FUNCDOM:COURommand),
The active trace of channel <Ch> (if otherwise),
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <stimulus> the stop value of the marker search
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Query Responst

<numeric>

1.3E9 (Planare TR1300/1)

Presetvalue 4.8E9 (TR5048)

3.0E9 (TR7530)
Equivalent Markers > Marker Search > Search Stop
Softkeys
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Remote Control Commands

CALC:MARK:FUNC:EXEC

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:EXECute

Executes the marker search according to the ggified criterion. The
type of the marker search is set by theCALC:MARK:FUNC:TYPE

D ipti
escription command.
(no query)
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]|2|3|4|5]|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8]|9]|10|11|12|13|14|15|16}
Related CALC:MARK:FUNC:TYPE
Commands CALC:MARK:FUNC:DOM
Markers > Marker Search > { Maximum | Minimum }
Equivalent Markers > Marker Search > Peak > { Search Peak | Search Max H
d | Search Peak Left| Search Peak Right }
Softkeys

Markers > Marker Search > Target { Search Target | Search Targe
Left | Search Target Right }
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Remote Control Commands

CALC:MARK:FUNC:PEXC

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion

<response>

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion?

Sets or reads out the peak excuien value, when the marker search

Description for peak is performed by theCALC:MARK:FUNC:EXEGcommand
(command/query).
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]|2]|3|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8|9|10|11]|12|13|14|15|16}
<resp onse> the peak excursion value, the range varies depending
Parameter
on the data format
Unit { dB (decibel) | ° (degree) |
Query Respons¢ <numeric>
Preset Value 1

Equivalent
Softkeys

Markers > Marker Search > Peak > Peak Excursion
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CALC:MARK:FUN®OL

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity <char>

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity?

Description

Selects the peak polarity, when the marker search for peak is
performed by the CALC:MARK:FUNC:EXEGcommand
(command/query)

Target

Marker <Mk> of the active trace of channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3]4|5|6|7|8|9|10]|11]|12|13|14|15|16}

Parameter

<char> specifies the peak polarity:
POSitive : Positive polarity
NEGative : Negative polarity

BOTH : Both positive polarity and negative polarity

Out of Range

The command is ignored.

Query Respons

{POS|NEG|BOTH}

Preset Value

POS

Related CALC:MARK:FUNC:EXEC

Commands

Equivalent Markers > Marker 8arch > Peak > Peak Polarity $Positive |
Softkeys Negative | Both }
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CALC:MARK:FUNC:TARG

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion: TARGet <response>

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TARGet?

Sets or reads out the target value, when the marker search for targg

Description is performed by the CALC:MARK:FUNC:EXECG:ommand
(command/query).
Marker <Mk> of the active trace of channel <Ch>,

Target <Ch>={[1]|2|3]|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8]|9]|10|11|12|13|14|15|16}

Parameter <response> the target value, the range varies depending on the
data format

Unit { dB (decibel) | ° (degree) |

Query Respons¢ <numeric>

Preset Value 0

Equivalent
Softkeys

Markers > Marker Search Target > Target Value
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CALC:MARK:FUNC:TRAC

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion: TRACKing

{ON|OFF|1|0}

CALCuUate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TRACking?

Sets or reads out the ON/OFF state of the marker search tracking

Description function (command/query).
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6 |718]9|10]11|12|13|14|15|16}
{ON|1} Marker search tracking ON
Parameter

{OFF|0}  Marker search tracking OFF

Query Responst

{0]1}

Preset Value

0

Equivalent
Softkeys

Markers > Marker Search > Tracking
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CALC:MARK:FUNC:TTR

CALCulate<Ch>[:SELected]:MARKe r<Mk>:FUNCtion: TTRansition
<char>

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TTRansition?

Selects the type of the target transition, when the marker search for
Description transition is performed by the CALC:MARK:FUNC:EXECzommand
(command/query).

Marker <Mk> of the active trace of channel <Ch>,
Targe <Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3]4|5|6|7|8|9|10|11]|12|13|14|15|16}

<char> specifies the type of the target transition:

POSitive : Positive target transition
Parameter NEGative : Negative targé transition
BOTH : Both positive target transition and negative target
transition

Out of Range | The command is ignored.

Query Respons¢ {POS|NEG|BOTH}

Preset Value POS

Related CALC:MARK:FUNC:EXEC

Commands

Equivalent Marker > Marker Searck Target > Target Transition X Positive |
Softkeys Negative | Both }
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CALC:MARK:FUNC:TYPE

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TYPE <char>

CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TYPE?

Selects the type of the marker search, which is pesfmed by the

Description | | ¢:MARK:FUNC:EXEQzommand (command/query).
Marker <Mk> the active trace of channel <Ch>,

Target <Ch>={[1]|2]3]4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6]7]8|9|10]11|12|13|14|15|16}
<char> specifies the type of the marker search:
MAXimum : Maximum value search
MINimum : Minimum value search
PEAK : Peak search

Parameter LPEak : Peak search to the left from the marker
RPEak : Peak search to the right from the marker
TARGet : Target search
LTARget : Target search to the left from the marker
RTARget : Target search to the right from the marker

Out of Range

The command is ignored.

Query Responst

{MAX|MIN|PEAK|LPE|RPE|TARG|LTAR|RTAR}

Preset Value MAX
Related CALC:MARK:FUNC:EXEC
Commands
Markers > Marker Search > { &imum | Minimum }
Equivalent Markers > Marker Search > Peak > { Search Peak | Search Max P¢
g Search Peak Left | Search Peak Right }
Softkeys

Markers > Marker Search > Target > { Search Target | Search Targ
Left | Search Target Right }
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CALC:MARK:REF

CALCulate<C h>[:SELected]:MARKer:REFerence[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:MARKer:REFerence[:STATe]?

Sets or reads out the ON/OFF state of the reference marker
(command/query).

Description When the reference marker is turned ON, all the values of the oén
markers turn to relative values.
The active trace of channel <Ch>,

Target <Ch>={[1]|2|3]45|6|7|8]9}
{ON|1} Reference marker ON

Parameter

{OFF|0}  Reference marker OFF

Query Respons{ {0|1}

Preset Value 0

Equivalent Markers > Reference Mer
Softkeys

87




Remote Control Commands

CALC:MARK:SET

CALCulate<Ch>[:SELected]:MARKer<Mk>:SET <char>

Description

Sets the value of the specified item to the value of the position of
the marker (no query).

Target

Marker <Mk> of the active trace of channel <Ch>,
<Ch>={[1]|2/3|4|5/6/7|8]9}
<Mk>={[1]|2|3]4|5|6|7|8]|9]|10|11|12|13|14|15|16}

Parameter

<char> specifies the type of the marker search:

STARt : Sweep start value set to the stimulus value of the
marker position.

STOP : Sweep stop value set to the stimulus value of the
marker posiion.

CENTer :Sweep center value set to the stimulus value of the
marker position.

RLEVel :Reference value set to the response value of the
marker position.

Out of Range

The command is ignored.

Equivalent
Softkeys

Markers > Marker Functions > { Magke >Start | Markee >Stop |
Markere >Center | Markeg >Ref Value }
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CALC:MARK:X

CALCulate<Ch>[:SELected]:MARKer<Mk>:X <stimulus>

CALCulate<Ch>[:SELected]:MARKer<Mk>:X?

Description Sets or reads out the stimulus value of the marker (command/query|
Marker <Mk> of the active trace of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8]|9]|10|11|12|13|14|15|16}
<stimulus> the stimulus value of the marker, the range is from
Parameter ) .
the stimulus start value to the stimulus stop value curretly set
Unit { Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt) }

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Stimulus center value

Equivalent
Softkeys

Markers > Hit Stimulus
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CALC:MARK:Y?

CALCulate<Ch>[:SELected]:MARKer<Mk>:Y?

Reads out the response value of the marker (query only).

If the reference marker is turned ON, the values of the markers fron
1 to 15 are read out as relative values to the refeence marker.

The data include 2 elements:

Description - . .
P <numeric 1> real number in rectangular format, real part in

polar and Smith chart formats;

<numeric 2> 0 in rectangular format, imaginary part in polar
and Smith chart formats.

Marker <Mk> of the actie trace of channel <Ch>,
Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Mk>={[1]|2|3|4|5|6|7|8]|9]|10|11|12|13|14|15|16}

Query Respons¢ <numeric 1>, <numeric 2>

Related CALC:MARK:REF
Commands

Equivalent

Softkeys None

CALC:MATHDEL

CALCulate<Ch>[:SELected]:MATH: DELete

Desciption Removes the dataAll memory traces)from the memory trace.

The active trace of channel<Ch>,

Target <Ch>={[1]|2]3|4|5|6|78]|9}

Equivalent

>
Softkeys Trace >Delete All Memory
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CALC:MATH:FUNC

CALCulate<Ch>[:SELected]:MATH:FUNCtion <char>

CALCulate< Ch>[:SELected]:MATH:FUNCtion?

Description

Selects the math operation between the measurement data and the
memory trace data. The math result replaces the data trace. If the
data trace is not saved, the command is ignored (command/query).

Target

The activetrace of channel <Ch>,
<Ch>={[1]2/3|4|5]6|7|8|9}

Parameter

<char> specifies the math operation:
DIVide : Division Data / Mem.
MULTiply  : Multiplication Data x Mem.
ADD : Addition Data+ Mem.
SUBTract :Subtraction Datag Mem.

NORMal : No math

Out of Range

Error occurs. The command is ignored.

Query Respons

{NORM|SUBT|DIV|ADD|MULT}

Preset Value NORM

Related CALC:MATH:MEM

Commands

Equivalent Trace> Data Math > { Data/Mem | Data*Mem | Data+Mem | Data
Softkeys Mem | OFF }
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CALOVMATH:MEM

CALCulate<Ch>[:SELected]:MATH:MEMorize

- Saves the measurement data to the memory trace. Automatically
Description )
turns on the display the memory trace (no query).
The active trace of channel <Ch>,
Target <Ch>={[1]|2|3/4/5|6|7|8|9}
Equivalent Trace> Display > Data >Memor
Sdtkeys play y
CALC:MST

CALCulate<Ch>[:SELected]:MSTatistics[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:MSTatistics[:STATe]?

Sets or reads out the ON/OFF state of the math statistics display

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON|1} Statistics display ON
Parameter
{OFF|0} Statistics display OFF
Query Respons¢ {0[1}
Preset Value 0
Equivalent Markers > Marker Math > Statistics > Statistics
Softkeys
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CALC:MST:DATA

CALCulate<Ch>[:SELected]:MSTatistics:DATA?

Reads out the math statistics values (query only).

The statistics function is applied either over the whole range (for all
the trace), or within the range specified byCALC:MST:DOM
command (the rangelimits are determined by two markers).

The data include 3 elements:

Description <numeric 1> Mean value:
<numeric 2> Standard deviation;
<numeric 3> Peale toe peak (difference between the
maximum value and the minimum value).
The active trace of channel <G>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Respons¢ <numeric 1>, <numeric 2>, <numeric 3>

Related CALC:MST:DOM
Commands

Equivalent

Softkeys None
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CALC:MST:DOM

CALCulate<Ch>[:SELected]:MSTatistics:DOMain[:STATe]

{ON|OFF|1]0}
CALCulate<Ch>[:SELected]:MSTatisti cs:DOMain[:STATe]?
- Sets or reads out the ON/OFF state of the math statistics range
Description
(command/query).
Target The active trace of channel <Ch>,
J <Ch>={[1]|2|3|4(516|7|8]|9}
{ON]1} Statistics range ON
Parameter
{OFF|0} Statistics range OFF
QueryResponse| {0[1}
Preset Value 0
Equivalent Markers > Marker Math > Statistics > Statistics Range
Softkeys
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CALC:MST:DOM:STAR

CALCulate<Ch>[:SELected]:MSTatistics:DOMain[:MARKer]:STARt
<numeric>

CALCulate<Ch>[:SELected]:MSTatistics:DOMain[:MARKer]:STARt?

Sets or reads out the number of the marker, which specifies the sta

Description frequency of the math statistics range (command/query).
Target The active trace of channel <Ch>,

9 <Ch>={[1]|2]3|4/5|6|7|8]|9}
Parameter <numeric> marker number from 1 to 16

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons¢ <numeric>

Preset Value 1

Equivalent

Markers > Marker Math > Statistics > Statistics Start
Softkeys
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CALC:MST:DOM:STOP

CALCulate<Ch>[:SELected]:MSTatistics :DOMain[:MARKer]:STOP

<numeric>

CALCulate<Ch>[:SELected]:MSTatistics:DOMain[:MARKer]:STOP?

Sets or reads out the number of the marker, which specifies the sto

Description frequency of the math statistics range (command/query).
Target The active trace ofchannel <Ch>,

9 <Ch>={[1]|2]3|4/5|6|7|8]|9}
Parameter <numeric> marker number from 1 to 16

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Markers > Marker Mah > Statistics > Statistics Stop
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CALC:PAR:COUN
CALCulate<Ch>:PARameter:COUNt <numeric>

CALCulate<Ch>:PARameter:COUNt?

Sets or reads out the number of traces in the channel

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Pamameter <numeric> the number of the trace in the channel from 1 to 16

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Responsg¢ <numeric>

Preset Value 1

Equivalent

Softkeys None
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CALC:PAR:DEF

CALCulate<Ch>:PARamet er<Tr>:DEFine <char>

CALCulate<Ch>:PARameter<Tr>:DEFine?

Description Sets the measurement parameter of the trace (command/query).
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3|4(516]7|8]|9}
<char> specifies the measuement parameter:
S11 : 11 parameter
S21 : S21 parameter

Parameter
A : Receiver A
B : Receiver B
R : Receiver R

Out of Range

Error occurs. The command is ignored.

Query Responst

{S11|S21|AB|R}

Preset Value

Depends on the trace number.
Tr1,Tr5,T9, Tr13 "S11"
Tr2,Tr6, Tr10, Tr 14 "S21"
Tr3, Tr7,Tr11, Tr 15 "S11"

Tr4,Tr8,Tr12, Tr16 "S21"

Equivalent
Softkeys

Response > Measurement > S11 | S21

Response > Measurement > { Abs A | Abs B | Abs R }
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CALC:PAR:SEL

CALCulate<Ch>:PAR ameter<Tr>:SELect

Description Sets the active trace in channel <Ch> (no query).

Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1](2|3]4|5|6|7|8|9}

If the trace number is greater than the number of the traces

Notes displayed in the channel, an error occurs and the command is
ignored.

Related CALC:PAR:COUN

Commands

Equivalent Trace> Active Trace

Softkeys
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CALC:PAR:SPOR

CALCulate<Ch>:PARameter<Tr>:SPORt <port>

CALCulate<Ch>:PARameter<Tr>:SPORt?

Sets or reads out the numbeof the receiver port, when performing

Description absolute measurements (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <port> the number of the receiver port from 1 to 2

Out of Range

Error occurs.The command is ignored.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Response > Measurement > { Abs A | Abs B }
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CALC:RLIM
CALCulate<Ch>[:SELected]:RLIMIt[:STATe] {ON|OFF|1|0}

CALCulate<Ch>[:SELected]:RLIMIit[:STATe]?

Remote Control Commands

Sets a reads out the ON/OFF state of the ripple limit test

Description (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON]|1} Ripple limit test ON
Parameter

{OFF|0}  Ripple limit test OFF

Query Responsg¢ {0]1}

Preset Value 0

Equivédent

Softkeys Analysis > Ripple Limit > Ripple Test
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CALC:RLIM:DATA

CALCulate<Ch>[:SELected]:RLIMit:DATA <numeric list>

CALCulate<Ch>[:SELected]:RLIMit:DATA?

Sets the data array, which is the limit line for the ripple limit
function (command/cuery).

The array size is 1 + 4N, where N is the number of limit line
segments.

For the re th point, where n from 1 to N:

<numeric 1> the number of limit line segments N is the
integer from O to 12. Setting O clears the
limit line.
Description <numeric4n 72>  type of the ne th limit line segment
1 0: Off.
T 1:0n
<numeric 4n 71>  the stimulus value in the beginning point of
the ne th segment
<numeric 4n 70>  the stimulus value in the end point of the
ne th segment
<numeric 4n+1> the ripple limit value of the ne th segment
The active trace of channel <Ch>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

If the array size is not 1 + 4N, where N isnumeric 1>, an error
occurs If <numeric 4n 1 2> is less than 0 or more than 1an error

Notes occurs When<numeric 4n 1 1>, <numeric 4n 10>, and
<numeric 4n+1> elements are out of allowable range, the value
is set to the limit, which is closer to the specified value.

Relded FORM:DATA

Commands

Equivalent Analysis > Ripple Limit > Edit Ripple Limit

Softkeys y PP PP
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CALC:RLIM:DISP:LINE

CALCulate<Ch>[:SELected]:RLIMit:DISPlay:LINE {ON|OFF|1]|0}

CALCulate<Ch>[:SELected]:RLIMit:DISPlay:LINE?

Sets or reads out the ON/OFFtate of the ripple limit line display

Description (command/query).
Target Active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON]|1} Ripple limit line ON
Parameter
{OFF|0}  Ripple limit line OFF
Query Respons¢ {0[1}
Preset Value 0
Equivalent Analysis > Ripple Limit > Limit Line
Softkeys y PP

CALC:RLIM:FAIL?

CALCulate#[:SELected]:RLIMit:FAIL?

Description Reads out the ripple limit test result (query only).
Taroet The active trace of channel <Ch>,
9 <Ch>={[1]|2]3|4|5|6|7|8]|9}
1 Fail
Query Responst
0 Pass
Equialent
Softkeys None
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CALC:RLIM:REP?

CALCulate<Ch>[:SELected]:RLIMit:REPort[:DATA]?

Reads out the data array, which is the ripple limit test results (query,
only).

The array size is 1+3N, where N is the number of ripple limit bands.
For the re th point, where n from 1 to N:

<numeric 1> N total number of the bands
Description <numeric 3n 71> n number of the band
<numeric 3n 70> Ripple value in the re th band
<numeric 3n+1> Ripple limit test result in the ne th band:
T O: Pass
1 1: Fail
Target The active trace of channel <Ch>,

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&=ORM:DATAcommand
setting.

Related FORM:DATA
Commands

Equivalent

Softkeys None
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CALC:SMO

CALCulate<Ch>[:SEL ected]:SMOothing[:STATe] {ON|OFF|1]|0}

CALCulate<Ch>[:SELected]:SMOothing[:STATe]?

Sets or reads out the ON/OFF state of the trace smoothing function

Description (command/query).
Target Active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON|1} Trace smoothing ON
Parameter

{OFF|0}  Trace smoothing OFF

Query Respons¢ {0[1}
Preset Value 0
Equivalent :
>
Softkeys Response > Smoothing
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CALC:SMO:APER

CALCulate<Ch>[:SELected]:SMOothing:APERture <numeric>

CALCulate<Ch>[:SELected]:SMOothing:APERture?

Sets or reads out the smoothing aperture, when performing

Descripion smoothing function (command/query).

Target Active_trace of channel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}

Parameter <numeric> the smoothing aperture from 0.01 to 20

Unit % (percent)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Response > Smo Aperture
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CALC:TRAC:DATA:FDAT?

CALCulate<Ch>:TRACe<Tr>:DATA:FDATa?

Reads out the formatted dataarray (query only).

The formatted data array is the data, whose processing is complete
including the formatting as the last step. Such data represent the
data trace values as they are shown on the screen.

The array size is 2N, where N is the number of nasurement points.
For the re th point, where n from 1 to N:

Description
<numeric 2n 11> real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cFORM:DATAcommand
setting.

Related CALC:DATA:FDAT
Commands

Equivédent

Softkeys None
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CALC:TRAC:DATA:FMEM?

CALCulate<Ch>:TRACe<Tr>:DATA:FMEMory?

Reads out the formatted memory array (query only).

The formatted memory array is the data, whose processing is
completed including the formatting as the last step.Such data
represent the memory trace values as they are shown on the screel
The array size is 2N, where N is the number of measurement pointg
For the re th point, where n from 1 to N:

Description
<numeric 2n 11> real number in rectangular format, real part
in polar and Smith chart formats;
<numeric 2n> 0 in rectangular format, imaginary part in
polar and Smith chart formats.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<numeric 1>, <numeric 2 >, é<numeric 2N>

The data transfer format depends on th&cFORM:DATAcommand
setting.

If the memory is empty, an error occurs and the command is

Notes .
ignored.
Related CALC:DATA:FMEM
Commands
Equivalent
Softkeys None
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CALC:TRAC:DATA:SDAT?

CALCulate<Ch>

‘- TRACe<Tr>:DATA:SDATa?

Reads out the corrected data array (query only).

The corrected data array is the data, whose processing is complete
excluding the formatting as the last step. Such data representsS
parameter complex values.

The array sie is 2N, where N is the number of measurement points.

Description For the ne th point, where n from 1 to N:
<numeric 2n 71>  the real part of corrected measurement;
<numeric 2n> the imaginary part of corrected
measurement.
The specified trace <Tr> of chanrle<Ch>,
Target <Tr>={[1]]2|3|4]5|6]|7|8}

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

Related CALC:DATA:SDAT
Commands

Equivalent

Softkeys None
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CALC:TRACATA:SMEM?

CALCulate<Ch>:TRACe<Tr>:DATA:SMEMory?

Reads out the corrected memory array (query only).

The corrected memory array is the data, whose processing is
completed excluding the formatting as the last step. Such data
represent & parametercomplex values.

The array size is 2N, where N is the number of measurement pointg
For the re th point, where n from 1 to N:

Description
<numeric 2n 71> the real part of corrected measurement
memory;
<numeric 2n> the imaginary part of corrected measurement
memory.
The specified trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cFORM:DATAcommand
setting.

If the memory is empty, an error occurs and the command is

Notes .
ignored.
Related CALC:DATA:SMEM
Commands
Equivalent
Softkeys None
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Remote Control Commands

CALC:TRAN:TIME

CALCulate<Ch>[:SELected]: TRANsform: TIME[: TYPE] <char>

CALCulate<Ch>[:SELected]: TRANsform: TIME[: TYPE]?

Selects the transfomation type for the time domain transformation

Description function: bandpass response or direct current circuit
(command/query).
The active trace of channel <Ch>,
Target <Ch>={[1]|2|3/4/5|6|7|8|9}
<char> specifies the transformation type:
Parameter BPASs :Bandpas

LPASs :Lowpass

Out of Range

The command is ignored.

Query Responst

{BPAS|LPAS}

Preset Value

BPAS

Equivalent
Softkeys

Analysis > Time Domain ResponseType > { Bandpass | Lowpass
Step | Lowpass Impulse }
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Remote Control Commands

CALC:TRAN:TIME:CENT

CALCulate<Ch>[:SELect ed]:TRANsform:TIME:CENTer <time>

CALCulate<Ch>[:SELected]:TRANsform: TIME:CENTer?

Sets or reads out the time domain center value, when the time

Description domain transformation function is turned ON (command/query).
Target The active trace of channel <Ch>
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the time domain center value, the range varies depending
Parameter o .
on the specified frequency range and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified &lue.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Analysis > Time Domain > Center
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Remote Control Commands

CALC:TRAN:TIME:IMP:WIDT

CALCulate<Ch>[:SELected]:TRANsform: TIME:IMPulse:WIDTh <time>

CALCulate<Ch>[:SELected]: TRANsform:TIME:IMPulse:WIDTh?

Sets or reads out the impulse width (time domain transformation
resolution), coupled with the Kaisee Bessel window shapeb

Description parameter. The impulse width setting changes thé parameter, and
setting of b parameter changes the impulse width (command/query
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the impulse width, the range varies depending on the
Parameter e .
specified frequency range and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, whichis closer to the specified value.

Query Respons

<numeric>

Equivalent
Softkeys

Analysis > Time Domain > Window > Impulse Width (when the
transformation type is set to Bandpass or Lowpass Impulse)
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Remote Control Commands

CALC:TRAN:TIME:KBES

CALCulate<Ch>[:SELected]:TRANsform:T

IME:KBESsel <numeric>

CALCulate<Ch>[:SELected]: TRANsform: TIME:KBESsel?

Sets or reads out theb parameter, which controls the Kaises Bessel

Description window shape, when performing time domain transformation
(command/query).
The active trace of chanel <Ch>,

Target <Ch>={[1]12]3/4/56|7|8]9}

Parameter <numeric> b parameter from 0 to 13

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Analysis > Time Domain > Widow > Kaiser Beta

CALC:TRAN:TIME:LPFR

CALCulate<Ch>[:SELected]: TRANsform: TIME:LPFRequency

Changes the frequency range to match with the lowpass type of the

Description time domain transformation function (no query).
Target The active trace of channel €h>,

9 <Ch>={[1]|2|3|4|5]|6|7|8|9}
ggfi:l/ea;int Analysis > Time Domain > Set Frequency Low Pass
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CALC:TRAN:TIME:REFL:TYPE

CALCulate<Ch>[:SELected]: TRANsform: TIME:REFLection: TYPE <char>

CALCulate<Ch>[:SELected]: TRANsform: TIME:REFLection: TYPE?

Selects the reflection distance either one way or round trip for the

Desciption time domain transformation function.
(command/query)
<char> Choose from:

Parameter RTRip :Round Trip
OWAY : One Way

Query Respons¢ {RTR|OWAY}

Preset Value RTR

Equivalent
Softkeys

Analysis > Time Domain Reflection Type> Round Trip | One Way
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Remote Control Commands

CALC:TRAN:TIME:SPAN

CALCulate<Ch>[:SELected]:TRANsform: TIME:SPAN <time>

CALCulate<Ch>[:SELected]:TRANsform:TI ME:SPAN?

Sets or reads out the time domain span value, when the time

Description domain transformation function is turned ON (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the time domain span value the range varies depending
Parameter o .
on the specified frequency range and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

2e1 8

Equivalent
Softkeys

Analysis > Time Domain > Span
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CALC:TRAN:TIME:STAR

CALCulate<Ch>[:SELected]:TRANsform: TIME:STARt <time>

CALCulate<Ch>[:SELected]:TRANsform: TIME:STARt?

Sets or reads out the time domain start value, when the time

Description domain transformation function isturned ON (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the time domain start value, the range varies depending on
Parameter o .
the specified frequency range and the number of points
Unit s (second)
Out of Rage Sets the value of the limit, which is closer to the specified value.
Query Respons{ <numeric>
Preset Value T1ei 8

Equivalent
Softkeys

Analysis > Time Domain > Start
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CALC:TRAN:TIME:STAT

CALCulate<Ch>[:SELected]: TRANsform: TIME:STATe {ON|OFF|1|0}

CALCuUate<Ch>[:SELected]: TRANsform:TIME:STATe?

Sets or reads out the ON/OFF state of the time domain

Description transformation function (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
{ON]1} Time domain transfomation ON
Parameter

{OFF|0} Time domain transformation OFF

Query Respons¢ {0[1}

Preset Value 0

Equivalent . . . . .
Analysis > Time Domain > Time Domain

Softkeys
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CALC:TRAN:TIME:STEP:RTIM

CALCulate<Ch>[:SELected]:TRANsform: TIME:STEP:RTIMe <time>

CALCulate<Ch>[:SELected] :TRANsform: TIME:STEP:RTIMe?

Sets or reads out the rise time of the step signal (time domain
transformation resolution), coupled with the Kaiseg Bessel window

Description shapeb parameter. The impulse width setting changes thé&
parameter, and setting ofb parameter changes the impulse width
(command/query).

The active trace of channel <Ch>,

Target <Ch>={[1]|2|3]4(56|7|8]9}
<time> the impulse width, the range variesdepending on the

Parameter e .
specified frequency range and the number of points

Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Analysis > Time Domain > Window > Impsé Width (when the
transformation type is set to Lowpass Step)
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CALC:TRAN:TIME:STIM

CALCulate<Ch>[:SELected]: TRANsform: TIME:STIMulus <char>

CALCulate<Ch>[:SELected]:TRANsform: TIME:STIMulus?

Selects the stimulus type for the time domain transfomation

Description function: impulse or step (command/query).
Target The aftive trace of channel <Ch>,

<Ch>={[1]|2|3|4|5|6|7|8|9}

<char> specifies the stimulus type:
Parameter IMPulse : Impulse

STEP . Step

Out of Range

The command is ignored.

Query Responst

{IMP|STEP}

Preset Value

IMP

Equivalent

Softkeys

Analysis > Time Domain *ResponseType > { Bandpass | Lowpass
Step | Lowpass Impulse }
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Remote Control Commands

CALC:TRAN:TIME:STOP

CALCulate<Ch>[:SELected]:TRANsform: TIME:STOP <time>

CALCulate<Ch>[:SELected]:TRANsform: TIME:STOP?

Sets or reads out the time domain stop value, when the time domail

Description transformation function is turned ON (command/query).
Target The active trace of channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<time> the time domain stop value, the ramge varies depending on
Parameter o .
the specified frequency range and the number of points
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

+1ei 8

Equivalent
Softkeys

Analysis >Time Domain > Stop
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CALC:TRAN:TIME:UNIT
CALCulate <Ch> [:SELected]:TRANsform:TIME:UNIT <char>

CALCulate <Ch> [:SELected]:TRANsform:TIME:UNIT?

Selects the the transformation unit for the time domain
Description transformation function: seconds, meters, feet
(command/query)

The active trace of channel <Ch>,

Target <Ch>={[1]|2|3]4|56|7|8|9}
<char> choose from:
SEC : Seconds
Parameter
MET : Meters
FEET : Feet

Query Response| {SEC|MET|FEET}

Preset Value SEC

Equivalent

S _ T _ _
Softkeys Analysis > Time Domair» Unit > Time, ns| Metric, m | Imperial, ft
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DISP:COL:BACK

DISPlay:COLor:BACK <numeric 1>,<numeric 2>,<numeric 3>

DISPlay:COLor:BACK?

Sets or reads out the background color for trace display

Description (command/query).
<numeric 1> Red value Rfrom 0O to 255;
Parameter <numeric 2> Green value G from O to 255;
<numeric 3> Blue value B from O to 255.
Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric 1>, <numeric 2>, <numeric 3>

Preset Value

0,0 ,0

Equivalent

Softkeys

Display > Color > Background
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Remote Control Commands

DISP:COL:GRAT
DISPlay:COLor:GRATiIcule <numeric 1>,<numeric 2>,<numeric 3>

DISPlay:COLor:GRATiIcule?

Sets or reads out the grid and the graticule label color for trace

Description display (command/query.
<numeric 1> Red value R from 0 to 255;
Parameter <numeric 2> Green value G from O to 255;
<numeric 3> Blue value B from 0 to 255.

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons¢ <numeric 1>, <numer ic 2>, <numeric 3>

Preset Value 160, 160, 164

Equivalent . .
Softkeys Display > Color > Grid
DISP:COL:RES
DISPlay:COLor:RESet
Description Restores the display settings to the default values (no query).
Equivalent :
Softkeys Display > Set Defaults
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Remote Control Commands

DISP:COITRAC:DATA

DISPlay:COLor:TRACe<Tr>:DATA <numeric 1>,<numeric 2>,

<numeric 3>

DISPlay:COLor:TRACe<Tr>:DATA?

Description Sets or reads out the data trace color (command/query).
Trace <Tr>,

Target <Tr>={[1]|2|3|4|5|6]7|8}
<numeric 1> Red value Rfrom O to 255;

Parameter <numeric 2> Green value G from 0O to 255;
<numeric 3> Blue value B from 0 to 255.

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric 1>, <numeric 2>, <numeric 3>

Preset Value

Varies depending on the trace number.

Equivalent

Softkeys

Display > Color > Data Trace
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DISP:COL:TRAC:MEM

DISPlay:COLor:TRACe< Tr>:MEMory <numeric 1>,<numeric

<numeric 3>

2>,

DISPlay:COLor:TRACe<Tr>:MEMory?

Description Sets or reads out the memory trace colofcommand/query).
Trace <Tr>,

Target <Tr>={[1]}2i3/4/5]6]7]8}
<numeric 1> Red value R from 0 to 255;

Parameter <numeric 2> Green value G from 0 to 255;

<numeric 3> Blue value B from 0 to 255.

Out of Range

Sets the value of the limit, which is closerto the specified value.

Query Responst

<numeric 1>, <numeric 2>, <numeric 3>

Preset Value

Varies depending on the trace number.

Equivalent _
Softkeys Display > Color > Memory Trace
DISP:ENAB

DISPlay:ENABIle

DISPlay:ENABIle?

{OFF|ON]|O|1}

Description Turns ON/OFF the display updatécommand/query).
{ON|1} ON

Parameter
{OFF|0} OFF

Query Respons¢ {0[1}

Preset Value 1

Equivalent
Softkeys

Display > Update
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DISP:FSIG

DISPlay:FSIGn {ON|OFF|1|0}

DISPlay:FSIGn?

Sets or reads out the ON/OFF statef the Fail sign display, when

Description performing limit test or ripple limit test (command/query).
{ON|1} Fail sign display ON

Parameter
{OFF|0} Fail sign display OFF

Query Responsd {01}

Preset Value |0

Equivalent Analysis > Limit Test > Fail Sign
Softkeys Analysis > Ripple Limit > Fail Sign
DISP:IMAG
DISPlay:IMAGe <char>

DISPlay:IMAGe?

Sets or reads out the inverted color display of the data traces

Description (command/query).
<char> choose from:

Parameter NORMal : Normal display
INVert - Inverted color display

Out of Range | The command is ignored.

Query Respons¢ {NORM|INV}

Preset Value NORM

gg;rjﬁm Display > Invert Color
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SYSTHIDE
SYSTem:HIDE
Description Hides the instrument GUI (no query).
Related SYST:SHOW
Commands
Equivalent
Softleys None
SYSTenBHOW
DISPlay:SHOW
- Shows the instrument GUI hidden by theSsYST:HIDE command (no
Description
query).
Related SYST:HIDE
Commands
Equivalent
Softkeys None
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DISP:MAX

DISPlay:MAXimize {ON|OFF|1|0}

DISPlay:MAXimize?

. Sets or reads ot the ON/OFF state of the window maximization of
Description .
the active channel (command/query).
{ON|1} Maximization ON
Parameter
{OFF|0} Maximization OFF
Query Respons¢ {0[1}
Preset Value 0
Equivalent Channel > Maximize | hannel
Softkeys
DISP:SPL

DISPlay:SPLit <numeric>

DISPlay:SPLit?

Sets or reads out the layout of the channel windows on the screen

Description (command/query).
The channel window layout on the screen see below.
<numeric> the number of the channel window layout from 1 to
Parameter 10

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons

<numeric>

Preset Value

Equivalent
Softkeys

Channel > AllocateChannels
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Channel window layout on the screen

Remote Control Commands

1:
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DISP:UPD

DISPlay:UPDate[:IMMediate]

Updates the display once, when the display update is set to OFF by

Description the DISP:ENAB command.(no query).
Rehted DISP:ENAB

Commands

Equivalent

Softkeys None
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Remote Control Commands

DISP:WIND:ACT

DISPlay:WINDow<Ch>:ACTivate

Description Sets the active channel (no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}
Notes At attempt to set to the active channel the channel, whih is not
displayed by theDISP:SPL command, an error occurs.
Related DISP:SPL
Commands
Equivalent Channel > Active Channel
Softkeys
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Remote Control Commands

DISP:WIND:ANN:MARK:ALIG

DISPlay:WINDow<Ch>:ANNotation:MARKer:ALIGn[: TYPE] <char>

DISPlay:WINDow<Ch>:ANNotation:MARKer:A LIGn[:TYPE]?

Sets or reads out the alignment mode of the marker display positior]
of each trace, when the only active trace display feature is turned

Description | ek by theDISP:WIND:ANN:MARK:SING command
(command/query).
Channel <Ch>,
Target <Ch>={[1]|2]3  |4/5|6|7|8|9}
<char> choose from:
VERTical : Vertical alignment
Parameter

HORizontal :Horizontal alignment

NONE : No alignment

Out of Range

The command is ignored.

Query Responst

{NONE|VERT|HOR}

Preset Value

NONE

Related DISP:WIND:ANN :MARK:SING

Commands

Equivalent _ _ _ _

Softkeys Markers > Properties > Align > { Vertical | Horizontal | OFF }
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Remote Control Commands

DISP:WIND:ANN:MARK:SING

DISPlay:WINDow<Ch>:ANNotation:MARKer:SINGIle[:STATe]

{ON|OFF|1|0}

DISPlay:WINDow<Ch>:ANNotation:MARKer:SINGIle[:STATe]?

Setsor reads out the ON/OFF state of the marker display for the

D ipti :
escription active trace only (command/query).
Taroet Channel <Ch>,
g <Ch>={[1]|2|3|4]5|6]7|8|9}
{ON]1} Only active trace markers display ON
Parameter
{OFF|0}  Only active trace markers display OFF
Query Rsponse | {0[1}
Preset Value 1
Equivalent Markers > Properties > Active Onl
Softkeys P Y

DISP:WIND:MAX

DISPlay :WINDow<Ch>:MAXimize {ON|OFF|1|0}

DISPlay :WINDow<Ch>:MAXimize?

Sets or reads out the ON/OFF state of the active trace maximizatior

Description of the specified channel (command/query).
{ON|1} Maximization ON

Parameter
{OFF|0} Maximization OFF

Query Respons¢ {0[1}

Preset Value 0

Equivalent Trace > Maximize Trace

Softkeys
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DISP:WIND:SPL

DISPlay:WINDow<Ch>:SPLit <numeric>

DISPlay:WINDow<Ch>:SPLit?

Remote Control Commans

Sets or reads out the layout of the graph in the channel window

Description (command/query).
The graph layout in the channel window see below.
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <numeric> the number of the graph layout from 1 to 9

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Trace > Allocate Traces

Graph layout in the channel window
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Remote Control Commands

DISP:WIND:TITL

DISPlay:WINDow<Ch>:TITLe[:STATe] {ON|OFF|1]|0}

DISPlay:WINDow<Ch>:TITLe[:STATe]?

Sets or reads out the ON/OFF state of the channel title display

Description (command/query).
Taroet Channel <Ck,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
{ON]1} Channel title display ON
Parameter
{OFF|0} Channel title display OFF
Query Respons¢ {0[1}
Preset Value 0
Equivalent . .
Softkeys Display > Title Label

DISP:WIND:TITL:DATA

DISPlay:WINDow<Ch>:TITLe:DATA <string>

DISPla y:WINDow<Ch>:TITLe:DATA?

Description Sets or reads out the channel title label (command/query).
Target Chamjel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <string>, up to 256 characters(quoted string)
Query Responsq <string>
Preset Value
St one
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Remote Control Commands

DISP:WIND:TRAC:ANN:MAREM

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer: MEMory <bool >
DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer: MEMory?
Description Turns ON/OFF the state of the memory value display on the marker

Trace <Tr>of channel <Ch>,

Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3]4[5|6]7|8|9}
<bool > Specifies the memory value display:
Parameter {ON|1} ON
{OFF|0} OFF
Query Respons¢ {0[1}
Preset Value 0

Equivalent
Softkeys

Markers > Properties Memory Value
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DISP:WINDIRAC:ANN:MARK:POS:X

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition: X

<numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition: X?

Sets or reads out the display position of the marker value on the&

Description axis by a percentage of thedisplay width (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3|4|5|6|7|8|9}
<numeric> the display position of the marker value on the X axis
Parameter
from O to 100
Unit % (percent)

Out of Range

Sets the valueof the limit, which is closer to the specified value.

Query Respons

<numeric>

Preset Value

Equivalent
Softkeys

Markers > Properties > Data X Position
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Remote Control Commands

DISP:WIND:TRAC:ANN:MARK:POS:Y

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:Y

<numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:ANNotation:MARKer:POSition:Y?

Sets or reads out the display position of the marker value on thegy

Description axis by a percentage of the display height (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7 |8}
<Ch>={[1]|2|3|4|5|6|7|8|9}
<numeric> the display position of the marker value on the ¥ axis
Parameter
from O to 100
Unit % (percent)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responsg¢ <numeric>

Presetvalue 0

Equivalent . i,
Markers > Properties > Data Y Position

Softkeys

DISP:WIND:TRAC:Y:AUTO

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:AUTO

Description Executes the auto scale function for the trace (no query).
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]|2|3 |4]5|6|7|8}
<Ch>={[1]|2|3|4[5|6]7|8]|9}

Equivalent

Softkeys Scale > Auto Scale

138




Remote Control Cormands

DISP:WIND:TRAC:Y:PDIV

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision <response>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision?

Sets or reads out the trace sda. Sets the scale per division, when

Description the data format is the rectangular format. Sets the full scale value,
when the data format is the Smith chart format or the polar format.
Trace <Tr> of channel <Ch>,

Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3|4|5|6 |718]|9}

Parameter <response> the scale value from 10E 18 to 1E18

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Varies depending on the format.

Logarithmic Magnitude: 10 dB/Div

Phase: 40 °/ Diwv
Expand Phase: 100 °/ Diwv
Group Delay: 10ec 9 s/Div

Smith Chart, Polar, SWR: 1 /Div
Linear Magnitude: 0.1 /Div

Real part, Imaginary part: 0.2 /Div

Equivalent

Softkeys

Scale > Scale
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Remote Control Commands

DISP:WIND:RACY:RLEV

DISPlay:WINDow<Ch>:TRAC e<Tr>:Y[:SCALe]:RLEVel <response>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RLEVel?

Sets the value of the reference line (response value on the refereng

Description line). For the rectangular format only (command/query).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3|4|5|6|7|8|9}
Parameter <response> the reference value from 10E 18 to 1E18
Unit { dB (decibel) | ° (degree) |

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Regmpnse

<numeric>

Preset Value

0 (except for SWR: 1)

Equivalent
Softkeys

Scale > Ref Value
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DISP:WIND:TRAC:Y:RPOS

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition <numeric>

DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition?

Sets the position ofthe reference line. For the rectangular format

Description only (command/query).

Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}

<Ch>={[1]|2|3|4|5|6|7|8|9}

<numeric> the reference line position from 0 to the number of the
Parameter scale divisions (set ly the DISP:WIND:Y:DIV command, 10 by

default)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

5 (except for SWR: 0)

Equivalent
Softkeys

Scale > Ref Position
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DISP:WIND:Y:DIV
DISPlay:WINDow<Ch>:Y[:SCALe]:DIVisions <numeric>

DISPlay:WINDow<Ch>:Y[:SCALe]:DIVisions?

Sets the number of the vertical scale divisions. For the rectangular

Description format only (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3]4/5|6|7|8|9}
Parameter <numeric> the number of the vertical scale divisions from 4 to 30

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>

Preset Value 10

Resolution 2

Equivalent

Softkeys Scale > Divisions
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FORM:BOR

FORMat:BORDer <char>

FORMat:BORDer?

Sets or reads out the transfer order of each byte in data, when the

Description binary data transfer format is set by theFORM:DATAcommand
(command/query).
<char> choose from:

Parameter NORMal : Normal (from the mast significant byte)

SWAPped :Swapped (from the least significant byte)

Out of Range

The command is ignored.

Query Responst

{NORM|SWAP}

Preset Value NORM
Related FORM:DATA
Commands

Equivalent

Softkeys None
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FORM:DATA

FORMat:DATA <char>

FORMat:DATA?

Description

Sets or reads out the data transfer format, when responding to the
following queries:
CALC:DATA:FDAT?
CALC:DATA:FMEM?
CALC:DATA:SDAT?
CALC:DATA:SMEM?
CALC:FUNC:DATA?
CALC:LIM:DATA?
CALC:LIM:REP?
CALC:LIM:REP:ALL?
CALC:RLIM:DATA?
CALC:RLIM:RE P?
SENS:FREQ:DATA?
SENS:SEGM:DATA?

(command/query)

Parameter

<char> choose from:
ASCii : Character format
REAL : Binary format (IEEE 64 floating point)

REAL32 : Binary format (IEEE 32 floating point)

Out of Rage

The command is ignored.

Query Rgsonse

{ASC|REAL|REAL32}

Preset Value ASC

Related FORM:BORD
Commands

Equivalent

Softkeys None
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HCOP
HCOPy[:IMMediate]
Description Prints out the image displayed on the screen without previewing (ng
query).
Equivalent System > Print > Print Ehbedded
Softkeys y
HCOP:ABOR
HCOPy:ABORt
Description Aborts the printout (no query).
Equivalent
Softkeys None

HCOP:DATE:STAM

HCOPy:DATE:STAMp {ON|OFF|1|0}

HCOPy:DATE:STAMp?

Sets or reads out the ON/OFF state of the current date and time

Description printout in th e upper right corner (command/query).
{ON]1} Date & time printout ON

Parameter
{OFF|0} Date & time printout OFF

Query Respons¢ {0[1}

Preset Value 1

Equivalent . : .
System > Print > Print Date & Time

Softkeys
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HCOP:IMAG
HCOPy:IMAGe <char>

HCOPy:IMAGe?

Sets or reads out the inverted color image printout

Desription (command/query).
<char> choose from:
Parameter NORMal :Normal printout

INVert : Inverted color printout

Out of Range | The command is ignored.

Query Respons¢ {NORM|INV}

Preset Value NORM

Equivalen .
Softkeys System > Print > Invert Image
HCOP:PAIN

HCOPy:PAINt <char>

HCOPy:PAINt?

- Sets or reads out the color chart for the image printout
Description

(command/query).

<char> choose from:

COLor : Color printout
Parameter

GRAY : Grayscaleprintout

BW : Black&white printout

Out of Range | The command is ignored.

Query Respons¢ {COL|GRAY|BW}

Preset Value BW

Equivalent

> Print > Pri
Softkeys System > Print > Print Color
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Remote Control Commands

INITiate<Ch>[:IMMediate]

Sets the channel to the single triggermode. Before this command is
sent, the channel must be in hold state, therwise an error occurs
and the command is ignored.

Description On completion of the sweep, the channel goes back into the hold
state.
The command is completed before the end of the sweep.
(no query)

Taroet Channel <Ch>,

9 <Ch>={[1]|2|3]4|5|6|7|8|9}

The sweep start in single trigger mode depends on the trigger
source. If the trigger is set to internal, the sweep will start

Notes . . . o . .
immediately upon the single mode activation. If the trigger is set
otherwise, the sweep will start when the trigger signal is received.

Related TRIG:SOUR

Commands

Equivalent . . .

> >
Softkeys Stimulus > Trigger > Single
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INIT:CONT

INITiate<Ch>:CONTinuous {ON|OFF|1]0}

INITiate<Ch>:CONTinuous?

Sets or reads out the ON/®BF state of the continuous trigger

Description initiation mode. If the continuous trigger initiation mode is set to
OFF, the channel tuns to the hold state (command /query).
Channel <Ch>,

Target <Ch>={[1]|2|3|4|5/6|7|8]9}
{ON|1} Continuous trigger initiation mode ON

Parameter
{OFF|0} Continuous trigger initiation mode OFF

Query Responsd {01}

Preset Value 1

The sweep start in continuous trigger initiation mode depends on
the trigger source. If the trigger is set to internal, the sweeps will go

Notes immediately one after another. If the trigger is set otherwise, the
sweep will start when the trigger signal is received.
Related TRIG:SOUR
Commands
Equivalent Stimulus > Trigger > Continuous
Softkeys Stimulus > Trigger > Hold
MMEM:COPY

MMEMory:COPY <string1>,<str

ing2>

Description Copies a file (no query).

<stringl> Source file name(quoted string)
Parameter

<string2> Destination file name (quoted string)
Equivalent
Softkeys None

148




Remote Control Commands

MMEM:DEL
MMEMory:DELete <string>
Description Deletes a file (no query).
Paramegr <string> File name (quoted string)
Equivalent
Softkeys None
MMEM:LOAD

MMEMory:LOADI[:STATe] <string>

Recalls the specified instrument state file. The file must be saved by

Description the MMEM:STORommand (no query).
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \State subdirectory of
Notes the main directory will be searched for the file. The instrument state
file has *.sta extension by default.
Equivalent System> Save/Recall > Stag
Softkeys y
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MMBM:LOAD:CHAN

MMEMory:LOAD:CHANNel[:STATe] <char>

Recalls the instrument state for the active channel. The file must be

Description saved in one of the four memory registers by the
MMEM:STOR:CHAKbommand (no query).

Target Active channel set by theDISP:WIN D:ACT command
<char> choose from:
A : Recall from register A

Parameter B : Recall from register B
C : Recall from register C
D : Recall from register D

Out of Range

The command is ignored.

Equivalent
Softkeys

System > Save/Recall > Chaeh{ State A|B|C | D}

MMEM:LOAD:CKIT

MMEMory:LOAD:CKIT<Ck> <string>

Recalls the definition file for the calibration kit. The file must be

Description saved by theMMEM:STOR:CKidommand (no query).
Target Calibration kit <Ck>,
9 <Ck>={[1]|2|3|4|5]6]7| 8/9|10|11}

Parameter <string> Fine name(quoted string)
If the full path of the file is not specified, the \CalKit subdirectory of

Notes the main directory will be searched for the file. The calibration kit
definition file has *.ckd extension by default.

Equivalent

Softkeys None

150




Remote Control Commands

MMEM:LOAD:LIM

MMEMory:LOAD:LIMit <string>

Recalls the limit table file. The file must be saved by the

Description | \IMEM:STOR:LIMcommand (no query).

Active trace of the active channel, set by th&CALC:PAR:SEL
Target

command
Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file.The limit table file
has *.lim extension by default.

Equivalent

Analysis > Limit Test > Edit Limit Line > Restore Limit Table
Softkeys
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MMEM:LOAD:RLIM

MMEMory:LOAD:RLIMit <string>

Recalls the ripple limit table file. The file must be saved by

Description | \1MEM:STOR:RLIMhe command (no query).
Active trace of the active channg set by the CALC:PAR:SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file.The ripple limit file
has *.rim extension ly default.
Equivalent Analysis > Ripple Limit > Edit Ripple Limit > Restore Ripple Limit
Softkeys Table

MMEM:LOAD:SEGM

MMEMory:LOAD:SEGMent <string>

Recalls the segment table file. The file must be saved by the

Description MMEM:STOR:SEGkEbmmand (no quey).
Target Active channel, set by theDISP:WIND:ACT command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Segment subdirectory
Notes of the main directory will be searched for the file. The segment file
has *.seg extension by default.
Equivalent .
Stimulus > Segment Table > Recall
Softkeys
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MMEM:MDIR
MMEMory:MDIRectory <string>
Description Creates a new directory (no query).
Parameter <string> Directory full name (quoted string)
Equivalent
Softkeys None
MMEM:STOR

MMEMory:STORe[:STATe] <string>

Description Saves the instrument state into a file (no query).

Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \State subdirectory of
Notes the main directory will be searched for the file. The state file has
*.sta extension by default.

Equivalent

Softkeys System > Save- State
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MMEM:STOR:CHAN

MMEMory:STORe:CHANnNel[:STATe] <char>

Description Saves the instrument state of thg items set for the active channel
into one of the four memory registers (no query).
Target Active channel set by theDISP:WIND:ACT command
<char> choose from:
A : Save to register A
Parameter B : Save to register B
C : Save to register C
D : Save to register D
Out of Range | The command is ignored.
gg;i:/:;im System >Save/Recall >Channel > { State A|B|C | D}

MMEM:STOR:CHAN:CLE

MMEMory:STORe:CHANnNel:CLEar

_ Clears the memory of the channel state saved by the
Description
MMEM:STOR:CHABbmmand (no query).
Equivaent System >Save/Recall > Channel > Clear States
Softkeys
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MMEM:STOR:CKIT

MMEMory:STORe:CKIT<Ck> <string>

Description Saves the definition file for the calibration kit (no query).
Target Calibration kit <Ck>,
9 <Ck>={[1]|2|3|4|5|6|7|8|9]10|11}

Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \CalKit subdirectory of

Notes the main directory will be searched for the file. The calibration kit
definition file has *.ckd extension by default.

Equivalent

Softkeys None

MMEM:STOR:FDAT

MMEMory:STORe:FDATa <string>

Description Saves the CSV formatted data into a file (no query).
Active trace of the active channel, set by theCALC:PAR:SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the\CSV subdirectory of
Notes the main directory will be searched for the file.The file has *.csv
extension by default.
Equivalent System > Save > Save Trace Data
Softkeys y
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MMEM:STOR:IMAG

MMEMory:STORe:IMAGe <string>

Desciption Saves the display image in BMP or PNG format into a file (no query|
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Image subdirectory of
Notes the main directory will be searched for the file. Ifthe file has *.png
extension, the file had PNG format, in all the other cases the file hay
BMP format.
Equivalent System > Print > Print Wi ndows
Softkeys y

MMEM:STOR:LIM

MMEMory:STORe:LIMit <string>

Description Saves the limit table into a file (no query).
Active trace of the active channel, set by theCALC:PAR:SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched forthe file. The file has *.lim
extension by default.
Equivalent Analysis > Limit Test > Edit Limit Line > Save Limit Table
Softkeys
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MMEM:STOR:RLIM

MMEMory:STORe:RLIMit <string>

Description Saves the ripple limit table into a file (no query).
Active trace of the active channel, set by theaCALC:PAR:SEL
Target
command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Limit subdirectory of
Notes the main directory will be searched for the file.The ripple limit file
has *.rim extension by default.
Equivalent : . - Lo - . -
Softkeys Analysis > Ripple Limit > Edit Ripple Limit > Save Ripple Limit Tablg

MMEM:STOR:SEGM

MMEMory:STORe:SEGMent <string>

Description Save the segment table in a file (no query).
Target Active channel,set by the DISP:WIND:ACT command
Parameter <string> File name (quoted string)
If the full path of the file is not specified, the \Segment subdirectory
Notes of the main directory will be searched for the file.The segment file
has *.seg extension by defult.
Equivalent Stimulus > Segment Table > Sav
Softkeys g
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MMEM:STOR:SNP

MMEMory:STORe:SNP[:DATA] <string>

Saves the measured Sparameters of the active channel into a
Touchstone file. The file type (E port or 2¢ port) is set by the
MMEM:STONP:TYPE:S1P and MMEM:STOR:SNP:TYPE:S2P
commands. E port type file saves one reflection parameter: S11 or

Description S22. Z port type file saves all the four parameters: S11, S21, S12,
S22.
(no query)
Target Active channel, set by theDISP:WIND:ACT command
Paraneter <string> File name (quoted string)
If the full path of the file is not specified, the \FixtureSim
subdirectory of the main directory will be searched for the file. The
Notes . .
1e port measurement file has *.slp extension; the 2port
measurement file has*.s2p extension.
Equivalent .
System > Save > Touchstone File > Save
Softkeys
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MMEM:STOR:SNP:FORM

MMEMory:STORe:SNP:FORMat <char>

MMEMory:STORe:SNP:FORMat?

Sets the data format for the $ parameter saving by the

Description MMEM:STOR:SNP command (commandéay).
Target Active channel, set by theDISP:WIND:ACT command
<char> choose from:
MA : Logarithmic Magnitude / Angle format
Parameter
DB : Linear Magnitude / Angle format
RI : Real part /Imaginary part format

Out of Range

The command is igrored.

Query Responst

{RI|DB|MA}

Preset Value

RI

Equivalent
Softkeys

System > Save > Touchstone File > Format

MMEM:STOR:SNP:TYPE:S1P

MMEMory:STORe:SNP  TYPE:S1P <port>

MMEMory:STORe:SNP. TYPE:S1P?

Sets the Lport Touchstone file type (*.s1p)and the port number,

Description when saving £ parameters by theMMEM:STOR:SNIEommand.
(command/query)

Parameter <port> port number from 1 to 2

Query Response |<numeric>

Preset Value 1

Equivalent Softkey System> Save> TouchstoneFile > Type > 1-Port (s1p)
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MMBM:STOR:SNP:TYPE:S2P

MMEMory:STORe:SNP. TYPE:S2P <rcvport>, <srcport>

MMEMory:STORe:SNP. TYPE:S2P?

Sets the 2port Touchstone file type (*.s2p) and the port numbers,

Description when saving & parameters by theMMEM:STOR:SNommand.
(command/query)
<rcvport > the number of the receiver portfrom 1 to 2
Parameter

<srcport> the number of the sourceport 1

Query Response

<numericl>, <numeric2>

Equivalent Softkey

System> Save> TouchstoneFile > Type > 2-Port (s2p)
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MMEM:STOR:STYP
MMEMory:STORe:STYPe <char>

MMEMory:STORe:STYPe?

Selects the type of the instrument or channel state saving by the

Description | \IMEM:STOR:CHANommand (command/query).

<char> choose from:

STATe : Measurement conditions

CSTate : Measurement conditions and calibratiortables
Parameter

DSTate : Measurement conditions and data traces

CDSTate : Measurement conditions, calibration tables and

data traces

Out of Range | An error occurs.

Query Respons¢ {STAT|CST|DST|CDST}

Preset Value CST

Equivalent

Softkeys System >Save > Sae Type
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MMEM:TRAN?

MMEMory:TRANsfer? <string>

Description

Transfers the contents of a specified file from the instrument to the
external computer (command/query).

Parameter

<string> the file name with the full path (quoted string)

Query Responst

Block data transfer format. For example:

#6001000 <binary block with length of 1000 bytes>

#6 Symbol# introduces the data block. The next
number indicates how many of the following digits
describethe length of the data block;

001000 Length of the data block;

Notes The file must be 20 Mbytes or less.
Equivalent
Softkeys None

OuUTP

OUTPUt[:STATe] {ON|OFF|1|0}

OUTPUt[:STATe]?

Sets or reads out the ON/OFF state of the stimulus signal output.

Description Measurements cannot be performed when the stimulus ghal
output is set to OFF (command/query).
{ON|1} Stimulus signal output ON
Parameter
{OFF|0}  Stimulus signal output OFF
Query Responsg {0|1}
Preset Value 1
Equivalent :
Stimulus > Power > RPut Off
Softkeys

162




Remote Control Commands

SENS:AVER
SENSe<Ch>:AVERage[:STATe] {ON|O FF|1|0}

SENSe<Ch>:AVERage[:STATe]?

Sets or reads out the ON/OFF state of the averaging function

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}
{ON]1} Averaging ON
Parameter

{OFF|0}  Averaging OFF

Query Responsg¢ {0]1}

Preet Value 0
Equivalent .
>
Softkeys Response > Averaging

SENS:AVER:CLE

SENSe<Ch>:AVERage:CLEar

- Restarts the averaging process, when averaging function is set to
Description
ON (no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Related SENSAVER
Commands
Equivalent
Softkeys None
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SENS:AVER:COUN

SENSe<Ch>:AVERage:COUNt <numeric>

SENSe<Ch>:AVERage:COUNTt?

Sets or reads out the averaging factor, when the averaging function

Description is set to ON (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4] 5/6/7|8|9}
Parameter <numeric> the averaging factor from 1 to 999

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responsg¢ <numeric>
Preset Value 10
Related SENS:AVER
Commands
Equivalent
>
Softkeys Response > Avdractor
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SENS:BAND
SENSe<Ch>:BANDwidth[:RESolution] <frequency>

SENSe<Ch>:BANDwidth[:RESolution]?

SENS:BWID
SENSe<Ch>:BWIDth[:RESolution] <frequency>

SENSe<Ch>:BWIDth[:RESolution]?

Description Sets or reads out the IF bandwidth (command/query).

Channel <Ch>,

Target <Ch>={[1]|2|3/4|5|6|7|8|9}

Parameter <frequency> the IF bandwidth value from 1 to 30000

Unit Hz (Hertz)

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Responsg¢ <numeric>

Preset Value 10000

Resolutbn In steps of 10, 30, 100, 300, 1000, 3000, 10000, 30000

Equivalent

Softkeys Response > IF Bandwidth
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SENS:CORR:CLE

SENSe<Ch>:CORRection:CLEar

Description Clears the calibration coefficient table (no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|23]4/5/6|7|8 |9}
Equivalent
Softkeys None
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SENS:CORR:COEF

SENSe<Ch>:CORRectio n:COEFficient[:DATA]? <char> ,
<rcvport>,<srcport>,< numeric list >

SENSe<Ch>:CORRection:COEFfic ient[:DATA]? <char> ,
<rcvport>,<srcport>

Description

Writes or reads out the calibration coeffiognt data array
(command/query).

The array size is 2N, where N is the number of measurement points
For the re th point, where n from 1 to N:

<numeric 2n 71>  real part of the calibration coefficients

<numeric 2n> imaginary part of the calibration
coefficients

Target

Channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}

Parameter

<char> specifies the error term selection:

ER : Reflection tracking

ED : Directivity

ES : Source match

ET : Transmission tracking

EX - Isolation

EL : Load match

<rcvport>, the number of the receiver port from 1 to 2
<srcport> the number of the source port = 1
<numeric list> the calibration coefficient array

When ES, ER, or ED is used, the numbers of the poettsvport>

and <srcport> must be the same. When EL, ET, or EX isad, the
numbers of the ports<rcvport> and<srcport> must be
different.

Query Responsg

<pnumeric 1>, <pumeric 2>, é<nu

The written calibration coefficients become effective only after the

Notes SENS:CORR:COEF:SAVE command is executed.
Equivalen
Softkeys None
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SENS:CORR:COEF:METH:ERES

SENSe<Ch>:CORRection:COEFficient:METHod:ERESponse
<rcvport>,<srcport>

Selects the ports and sets the & path 2¢ port calibration type, when

Description the written calibration coefficients are made effective by the
SENS:CORR:COEF:SAVEEommand (no query).
Channel <Ch>,
farget <Ch>={[1]12]3/4/56|7|8]9}
<rcvport>,  the number of the receiver port from 1 to 2
Parameter

<srcport>,  the number of the source port = 1

Out of Range

If an incorrect port number is specifiedan error occurs If the same
port numbers are specified, a error occurs

Related SENS:CORR:COEF:SAVE
Commands

Equivalent

Softkeys None
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SENS:CORR:COEF:METH:OPEN

SENSe<Ch>:CORRection:COEFficient:METHod[:RESPonse]:OPEN <port>

Selects the pot and sets the response calibration (Open) type, whel
Description the written calibration coefficients are made effective by the
SENS:CORR:COEF:SAVEEommand (no query).

Channel <Ch>,

Target <Ch>={[1]|2|3]4|5|6|7]8|9}

Parameter <port> the number of the port from 1 to 2

Out of Range | An error occurs..

Related SENS:CORR:COEF:SAVE
Commands

Equivalent

Softkeys None
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SENS:CORR:COEF:METH:SHOR

SENSe<Ch>:CORRection:COEFficient:METHod[:RESPonse]:SHORt

<port>
Selects the port and sets the response calibration (Sint) type, when
Description the written calibration coefficients are made effective by the
SENS:CORR:COEF:SAVEEommand (no query).
Channel <Ch>,
farget <Ch>={[1]|2/314|5/6|7/89}
Parameter <port> the number of the port from 1 to 2

Out of Range

An error occurs

Rehted SENS:CORR:COEF:SAVE
Commands

Equivalent

Softkeys None
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SENS:CORR:COEF:METH:SOLT1

SENSe<Ch>:CORRection:COEFficient:METHod:SOLT1 <port>

Selects the port and sets the full £ port calibration type, when the

Description written calibration coefficients are made effective by the
SENS:CORR:COEF:SAVEEommand (no query).
Channel <Ch>,

Target <Ch>={[1]|2/314/5/6/7/89}

Parameter <port> the number of the port from 1 to 2

Out of Range

An error occurs

Related SENS:CORR:COEF:SAVE
Commands

Equivalent

Softkeys None
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SENS:CORR:COEF:METH:THRU

SENSe<Ch>:CORRection:COEFficient:METHod[:RESPonse]:THRU
<rcvport>, <srcport>

Selects the ports and sets the response calibration (Thru) type, whe

Description the written calibration coefficients are made effective by the
SENS:CORR:COEF:SAVEcommand (no query).
Channel <Ch>,
farget <Ch>={[1]12]3/4/56|7|8]9}
<rcvport>,  the number of the receiver port from 1 to 2
Parameter

<srcport>,  the number of the source port = 1

Out of Range

If an incorrect port numberis specified,an error occursIf the same
port numbersare specified, an error occurs.

Related SENS:CORR:COEF:SAVE
Commands

Equivalent

Softkeys None
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SENS:CORR:COEF:SAVE

SENSe<Ch>:CORRection:COEFficient:SAVE

Description

Enables the written calibration coefficients cepending on the
selected calibration type.

On completion of the command the error correction automatically
turns ON.

At the attempt to execute this command before all the needed
calibration coefficients are written, an error occurs and the
command is ignaed (no query).

Target

Channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}

Related
Commands

Calibration type selection:
SENS:CORR:COEF:METH:ERES
SENS:CORR:COEF:METH:OPEN
SENS:CORR:COEF:METH:SHOR
SENS:CORR:COEF:METH:THRU
SENS:CORR:COEF:METH:SOLT1

Calibration codficient writing:
SENS:CORR:COEF

Equivalent
Softkeys

None
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SENS:CORR:COLL:CKIT

SENSe<Ch>:CORRection:COLLect:CKIT[:SELect] <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT[:SELect]?

Sets or reads out the number of the selected calibration kit

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <numeric> the number of the calibration kit from 1 to 11

Out of Range

Error occurs. The command is ignored.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Calibration > Cal Kit > Cal Kit n
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SENS:CORR:COLL:CKIT:LAB

SENSe<Ch>:CORRection:COLLect:CKIT:LABel <string>

SENSe<Ch>:CORRection:COLLect:CKIT:LABel?

Description Sets or reads out the calibration kit label (command/query).
Target Calibration kit, selected for channé<Ch>,

J <Ch>={[1]|2|3|4(516]7|8]|9}
Parameter <string>, up to 254 characters(quoted string)

Query Responst

<string>

Preset Value

Varies depending on the number of the calibration kit.

Equivalent
Softkeys

Calibration > Edit Cal Kit > Label
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SENS:CORR@LL:CKIT:RES

SENSe<Ch>:CORRection:COLLect:CKIT:RESet

Description Resets the calibration kit to the factory settings (no query).
Target Calibration kit, selected for channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
Equivalent Calibration > Restore Cal Ki
Softkeys

SENS:CORR:COLL:CKIT:STAN:CO

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C0O <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C0?

Sets or reads out the CO value for the open calibration standard

Description (command/query).
Standard <Std> othe calibration kit specified for channel <Ch>,
aret <Ch>={[1]]2/3/4/5]6]7]8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the CO value frome 1E18 to 1E18
Unit 1E£ 15 F (Farad)

Out of Range

Sets the vdue of the limit, which is closer to the specified value.

Query Responsg

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Capacitance > CO 40 F
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:C1

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C1 <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C1?

Sets or reads out the C1 value for the open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
aret <Ch>={[1]]2[3/4/5]6]7]8|9}
arge <Std>={[1]|2|...N}, where N & the number of the standards
in the calibration kit
Parameter <numeric> the C1 value frome 1E18 to 1E18
Unit 1Ee 27 F/Hz (Farad/Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equvalent
Softkeys

Calibration > Edit Cal Kit > Capacitance > C1 90 F/Hz
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Remote Control Commans

SENS:CORR:COLL:CKIT:STAN:C2

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C2 <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C2?

Sets or reads out the C2 value fortte open calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
T . <Ch>={[1]|2|3|4|5|6|7|8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the C2value frome 1E18 to 1E18
Unit 1Es 36 F/Hz2 (Farad/Hertz2)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Capacitance > C2 10 F/HZ
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Remote Control Commands

SENS:CORCOLL:CKIT:STAN:C3

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C3 <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:C3?

Sets or reads out the C3 value for the open calibration standard

Description (command/query).
Standard <Std> of the calibrtion kit specified for channel <Ch>,
aret <Ch>={[1]]2[3/4/5]6]7]8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the C3 value frome 1E18 to 1E18
Unit 1Es 45 F/Hz3 (Farad/Hertz3)

Out of Range

Sets the \alue of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Capacitance > C3 19 F/HZ
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:DEL

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:DELay <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:Delay?

Sets or reads out the offset delay value for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
aret <Ch>={[1]]2[3/4/5]6]7]8|9}
arge <Std>= {[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the offset delay value forme 1E18 to 1E18
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Offset Delay
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:LO

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:LO <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L0?

Sets or reads out the LO value for tk short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
aret <Ch>={[1]]2[3/4/5]6]7]8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the LO value frome 1E18 to 1E18
Unit 1Es 12 H (Henry)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Inductance > LO ¥*®* H
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L1 <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L1?

Sets or reads out the L1 value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit speciéd for channel <Ch>,
aret <Ch>={[1]]2[3/4/5]6]7]8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the L1 value frome 1E18 to 1E18
Unit 1Es 24 H/Hz (Henry/Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Inductance > L1 ¥&* H/Hz
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Remote Control Cormands

SENS:CORR:COLL:CKIT:STAN:L2

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L2 <numeric>

SENSe<Ch>:CORRection:COLL ect:CKIT:STAN<Std>:L2?

Sets or reads out the L2 value for the short calibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
T . <Ch>={[1]|2|3|4|5|6|7|8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the L2 value frome 1E18 to 1E18
Unit 1Es 33 H/Hz2 (Henry/Hertz2)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softleys

Calibration > Edit Cal Kit > Inductance > L2 ¥& H/Hz?
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:L3

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L3 <numeric>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:L3?

Sets or reads out the L3 value for the short cébration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
T . <Ch>={[1]|2|3|4|5|6|7|8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <numeric> the L3 value frome 1E18 to 1E18
Unit 1Es 42 H/Hz3 (Henry/Hertz3)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > Edit Cal Kit > Inductance > L3 ¥ H/HZ®
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Remote Control Commands

SENS:CORR:COLL:CKITAN:LAB

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:LABel <string>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:LABel?

Sets or reads out the label for the calibration standard

Description (command/query).
Standard <Std> of the calibration kit spedied for channel <Ch>,
T . <Ch>={[1]|2|3|4|5|6|7|8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <string>, up to 254 characters(quoted string)

Query Responst

<string>

Equivalent
Softkeys

Calibration > Edit CaKit > Label
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:LOSS
SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:LOSS <loss>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:LOSS?

_ Sets or reads out the offset loss value for the calibration standard
Description

(command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
Tarae <Ch>={[1]|2|3|4|5|6|7|8|9}
arg <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <loss> the offset loss value frome 1E18 to 1E18
Unit w/'s (Ohm/ second)

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons¢ <numeric>

Equivalent

Calibration > Edit Cal Kit > Offset Loss
Softkeys
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Remote Control Commands

SENS:CORR:COLL:CKIT:STAN:TYPE

SENSe<Ch>:CORRection:COLLect:CKIT:ST  AN<Std>:TYPE <char>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:TYPE?

Description

Sets or reads out the type of calibration standard (command/query)

Target

Standard <Std> of the calibration kit specified for channel <Ch>,
<Ch>={[1]|2|3]4[5|6]7|8]|9}

<Std> ={[1]|2]...N}, where N¢ the number of the standards
in the calibration kit

Parameter

<char> choose from:
OPEN :Open
SHORt  : Short
LOAD :Load

THRU :Thru

Out of Range

Error occurs. The command is ignored.

Query Responst

{OPEN|SHOR|LOAD|THRU}

Equivalent
Softkeys

Calibration > Edit Cal Kit > STD Type
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Remote ControlCommands

SENS:CORR:COLL:CKIT:STAN:Z0

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:Z0 <impedance>

SENSe<Ch>:CORRection:COLLect:CKIT:STAN<Std>:Z0?

Sets or reads out the offset Z0 value for the dibration standard

Description (command/query).
Standard <Std> of the calibration kit specified for channel <Ch>,
T . <Ch>={[1]|2|3|4|5|6|7|8|9}
arge <Std>={[1]|2|...N}, where N¢e the number of the standards
in the calibration kit
Parameter <impedance> the offset Z0 value frome 1E18 to 1E18
Unit W (Ohm)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

50 or 75, depending on the selected calibration kit

Equivalent
Softkeys

Calibration > Edit CakKit > Offset Z0

SENS:CORR:COLL:CLE

SENSe<Ch>:CORRection:COLLect:CLEar

Clears the measurement values of the calibration standards (no

Description query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8]|9}
Equivalent Calibration > Calibrate > { Rgsonse (Open) | Response (Short) |
Softkeys Response (Thru) | One Patke Port Cal | Full & Port Cal }> Cancel
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Remote Control Commands

SENS:CORR:COECAL:CHECK:EXEC

SENSe<Ch>:CORRection:COLLect:

ECAL:CHECK:EXECute <numericl>,

<numeric2>
Description Executing confidence check
Target AutoCal module
g (Che arbitrary number 1 to9)
Equivalent Calibration > Autocalibration >Confidence Check
Softkeys

SENS:CORR:COELCAL:ORI:EXEC

SENSe&Ch>: CORRection:COLLect: ECAL:ORIlentation:EXECute
<numericl>, <numeric2>

Description Executing AutoCalorientation to the ports Rev, Scr
Target AutoCal module
Equivalent L L . .

. Calibration > Autocalibration > Perform AuteOrientation
Softkeys
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Remote Control Commands

SENS:CORR:COLL:ECAL:ORI:STAT

SENSe:CORRection:COLLect:ECAL:ORIentation:STATe {ON|OFF|1|0}

SENSe:CORRection:COLLect:ECAL:ORlen tation:STATe?

Sets or reads out the ON/OFF state of the Aut®rientation function

Description used when executing AutoCal (command/query).
Target AutoCal

{ON|1} Auto-Orientation function ON
Parameter

{OFF|0} Auto-Orientation function OFF

Query Respoms

{0]1}

Preset Value

0

Equivalent
Softkeys

Calibration > AutoCal > Orientation > AutdOrientation
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Remote Control Commands

SENS:CORR:COLL:ECAL:PATH

SENSe:CORRection:COLLect:ECAL:PATH <numericl1>,<numeric2>

SENSe:CORRection:COLLect:ECAL:PATH? <numericl>

Sets or readsout the AutoCal module port number which is

Description connected to a specified port of Network Analyzer
(command/query).

Target AutoCal
<numericl> Network Analyzer Port Number,
<numeric2> AutoCal Module Port Number,
1 : Port A of AutoCal Module

Parameter

2 : Port B of AutoCal Module

3 : Port C of AutoCal Module

4 . Port D of AutoCal Module

Query Responst

<numeric>

Equivalent
Softkeys

Calibration > AutoCal > Orientation > Port £ Port A| Port 1 € Port
B|Portle PortJPortle PortD
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Remote Control Commands

SENS:CORRALL:ECAL:SOLT1

SENSe<Ch>:CORRection:COLLect:ECAL:SOLT1 <port>

Executes Full 1-port calibration of the specified port of specified

D - _
escription channel (Ch) using the AutoCal module (command only).
Channel <Ch>,
Target <Ch>={[1]|2]3|4|5|6]7|8|9}
Paramete <port> : Port Numberl
Equivalent Calibration > AutoCal >ull 1-Port Calbration
Softkeys

SENS:CORR:COLL:ECAL:SOLT

SENSe<Ch>:CORRection:COLLect:ECAL:SOLT1 <port 2>, <port 1>

Descrintion ExecutesOne Path 2Port calibration of the specified port of
P specfiied channel (Ch) using the AutoCal module (command only).

Channel <Ch>,

Target <Ch>={[1]|2]3|4/5/6|7|8]9}
<port 1> the number of the receiver port(always 1)

Parameter
<port 2>  the number of the sourceport (always 2)

Equivalent Calibration >AutoCal >One Path 2Port Calibration

Softkeys
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Remote Corrol Commands

SENS:CORR:COLL:ECAL:UCH
SENSe:CORRection:COLLect:ECAL:UCHar <char>

SENSe:CORRection:COLLect:ECAL:UCHar?

Sets or reads out the Characteristic used when executing AutoCal

Description (factory or user characterization) (command/query).
Target AutoCal

<char> specifies the stimulus type:

CHARO : factory characterization
Parameter CHAR1  :user characterization 1

CHAR2  :user characterization 2

CHAR3  :user characterization 3

Query Respons¢ {CHARO|CHAR1|CHAR2|CHAR3}

Preset Value CHARO

Equivalent

Calibration > AutoCal > Characterization
Softkeys
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Remote Control Commands

SENS:CORR:COLL:LOAD

SENSe<Ch>:CORRection:COLLect[:ACQuire]:LOAD <port>

Measures the calibration data of the load standard for the specified

Description port (no quety).
Channel <Ch>,
Target <Ch>={[1]|2|3|4/56|7|89}
Parameter <port> the number of the port from 1 to 2

Out of Range

Erroroccurs. The command is ignored.

The command start the measurement for the channel independently

Notes of the trigger and trigger source settings.The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Open) > Load (Optional)
et S Gali S S .
Equivalent Calibration > Calibrate > Response (Short) > Load (Optional)
Softkeys

Calibration > Calibrate > Full £ Port Cal > Load

Calibration > Calibrate > One Path£Port Cal > Load
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Remote Control Commands

SENS:CORR:COLL:METH:ERES

SENSe<Ch>:CORRection:COLLect: METHod:ERESponse <rcvport>,

<srcport>
Selects the ports and sets the one path 2port calibration type for
Descrintion the calculation of the calibration coefficients on completion of the
P calibration executed by the SENS:CORR:COLL:SAVEcommand
(no query).
Channel <Ch>,
Target <Ch>={[1]12]3/4/56/7|8]9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, a error occurs If the same
Out of Range | port numbers are specified, a error occurs The command is
ignored.
Related SENS:CORR:COLL:SAVE
Commands
Equivalent
Softkeys None
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Remote Control Commands

SENS:CRR:COLL:METH:OPEN

SENSe<Ch>:CORRection:COLLect:METHod[:RESPonse]:OPEN <port>

Selects the port and sets the response calibration (Open) type for
the calculation of the calibration coefficients on completion of the

Description | - libration executed by the SENS:CORR:COLL:SAVE command
(no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <port> the number of the port from 1 to 2

Out of Range

Erroroccurs. The command is ignored

Related SENS:CORR:COLL:SAVE
Commands

Equivalent

Softkeys None
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Remote Control Commands

SENS:CORR:COLL:METH: SHOR

SENSe<Ch>:CORRection:COLLect:METHod[:RESPonse]:SHORt <port>

Selects the port and sets the response calibration (Short) type for
the calculation of the calibration coefficients on completion of the

Description | - libration executed by the SENS:CORR:COLL:SAVEcommand
(no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <port> the number of the port from 1 to 2

Out of Range

Erroroccurs. The command is ignored

Related SENS:CORR:COLL:SAVE
Commands

Equivalent

Sofkeys None
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Remote Control Commands

SENS:CORR:COLL:METH:SOLT1

SENSe<Ch>:CORRection:COLLect:METHod:SOLT1 <port>

Selects the port and sets the full E port calibration type for the
calculation of the calibration coefficients on completion of the

Description | - libration executed by he SENS:CORR:COLL:SAVEcommand
(no query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <port> the number of the port from 1 to 2

Out of Range

Error occurs. The command is ignored.

Related SENS:CORR:COLL:SAVE
Commands

Equivalent

Softkeys None
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Remote Control Commands

SENS:CORR:COLL:METH:THRU

SENSe<Ch>:CORRection:COLLect:METHod[:RESPonse]: THRU <rcvport>,

<srcport>
Selects the ports and sets the response calibration (Thru) type for
Descrintion the calculation of the calibration coefficients on completion of the
P calibration executed by the SENS:CORR:COLL:SAVEcommand
(no query).
Channel <Ch>,
Target <Ch>={[1]12]3/4/56/7|8]9}
<rcvport> ,  the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1
If an incorrect port number is specified, @ error occurs If the same
Out of Range | port numbers are specified, a error occurs The command is
ignored.
Related SENS:CORR:COLL:SAVE
Commands
Equivalent
Softkeys None
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Remote Control Commands

SENS:CORR:COLL:METH:TYPE?

SENSe<Ch>:CORRection:COLLect:METHod: T YPE?

Reads out the calibration type selected for the calculation of the

Description calibration coefficients on completion of the calibration executed by
the SENS:CORR:COLL:SAVEcommand (query only).
Channel <Ch>,
Target <Ch>={[1]12]3/4/56/7|8]9}
RESPQO" :Response (Open)
RESPS : Response (Short)
RESPT : Response (Thru)
QueryResponse
SOLT1 : Full 1 port calibration
1PATH : One path Z port calibration
NONE : Not defined
Equivalent
Softkeys None
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Remote Control Commands

SENS:CORR:COLL:OPEN

SENSe<Ch>:CORRection:COLLect [:ACQuire]:OPEN <port>

Measures the calibration data of the open standard for the specified

D ipti
escription port (no query).
Channel <Ch>,
Target <Ch>={[1]|2|3|4/5|6|7|8|9}
Parameter <port> the number of the port from 1 to 2
Out of Range | Erroroccurs. The ommand is ignored
The command start the measurement for the channel independently
Notes of the trigger and trigger source settings.The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Open)Gpen
Equivalent Calibration > Calibrate > Full £ Port Cal > Open
Softkeys

Calibration > Calibrate > One Path&Port Cal > Open
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Remote Control Commands

SENS:CORR:COLL:SAVE

SENSe<Ch>:CORRection:COLLect:SAVE

Description

Calculates the calibration coefficients from the calibration standards
measuements depending on the selected calibration type.

On completion of the command, all the calibration standards
measurements are cleared and the error correction automatically
turns ON.

Before executing this command it is neccessery to select calibration
type by one of commandsSENS:CORR:COLL:METH:XXXX

At the attempt to execute this command before all the needed
standards are measured, an error occurs and the command is
ignored (no query).

Target

Channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}

Related
Commands

Calibration type selection:
SENS:CORR:COLL:METH:OPEN
SENS:CORR:COLL:METH:SHOR
SENS:CORR:COLL:METH:THRU
SENS:CORR:COLL:METH:ERES
SENS:CORR:COLL:METH:SOLT1

Calibration standards measurement:
SENS:CORR:COLL:LOAD
SENS:CORR:COLL:OPEN
SENS:CORR:COLL:SHOR
SENS:CORR:COLL:THRU

Equivalent
Softkeys

Calibration > Calibrate > { Response (Open) | Response (Short) |
Response (Thru) | One PathePort Cal | Full & Port Cal } > Apply
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Remote Control Commands

SENS:CORR:COLL:SHOR

SENSe<Ch>:CORRection:COLLect[:ACQuire]:SHORt <port>

Measures the calibration data of the short standard for the specified

D ipti
escription port (no query).
Channel <Ch>,
Target <Ch>={[1]|2|3|4/5|6|7|8|9}
Parameter <port> the number of the port from 1 to 2
Out of Range | Erroroccurs. The command is ignored
The commandstart the measurement for the channel independently
Notes of the trigger and trigger source settings.The command waits for
the completion of the measurement.
Calibration > Calibrate > Response (Short) > Short
Equivalent Calibration > Calibrate > Fulle Port Cal > Short
Softkeys

Calibration > Calibrate > One Path&£Port Cal > Short
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Remote Control Commands

SENS:CORR:COLL:THRU

SENSe<Ch>:CORRection:COLLect[:ACQuire]: THRU <rcvport>,

<srcport>
Measures the calibration data of the thru standard between the
Description receiver port<rc vport> and the source port<srcport> (no
query).
Channel <Ch>,
Target <Ch>={[1]|2]3/4/5/6|78|9}
<rcvport>, the number of the receiver port from 1 to 2
Parameter
<srcport>, the number of the source port =1

Out of Range

If an incorrect port number isspecified, a error occurs If the same
port numbers are specified, a error occurs The command is
ignored.

The command start the measurement for the channel independently

Notes of the trigger and trigger source settings.The command waits for
the completion of the measurement.
. Calibration > Calibrate > Response (Thru) > Thru
Equivalent
Softkeys

Calibration > Calibrate > One Path£Port Cal > Thru
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SENS:CORREXT
SENSe<Ch>:CORRection:EXTension[:STATe] {ON|OFF|1|0}

SENSe<Ch>:CORRection:EXTension[:STATe] ?

Remote Control Commands

Sets or reads out the ON/OFF state of the port extension function

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
{ON]1} Port extension function ON
Parameter

{OFF|0}  Port extension function OFF

Query Responsg¢ {0]1}

Pre®t Value 0

Equivalent . . . .
Calibration > Port Extensions > Extension

Softkeys

205




Remote Control Commands

SENS:CORR:EXT:PORT:FREQ

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:FREQuency{[1]|2}

<frequency>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:FREQuency{[1]|2}?

Description

Sets or reads outhe values of the frequency 1 and frequency 2 to
calculate the loss for the port extension function (command/query).

Target

Port <Pt> of channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>=([1][2}

Parameter

<frequency> the frequency value
from 3E5to 1.3E9 Planare TR1300/1),
from 2E4to 4.8E9 (TR5048),

from 2E4to 3.0E9 (TR7530)

Unit

Hz (Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

1E9

Equivalent
Softkeys

Calibration > Pat Extensions > Loss > { Freql | Freq2 }
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Remote Control Commands

SENS:CORR:EXT:PORT:INCL

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:INCLude{[1]|2}[:STATe]

{ON|OFF|1|0}
SENSe<Ch>:CORRection:EXTension:PORT<Pt>:INCLude{[1]|2}
[}STATe]?

Description Sets or reads out the ON/OFF statefahe compensation of the loss

P 1 and loss 2 for the port extension function (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3]4|5|6|7|8]|9}
{ON|1} Loss compensation ON
Parameter

{OFF|0}  Loss compensation OFF

Query Responsq {0|1}

Preset Value |0

Equvalent Calibration > Port Extensions > Loss > { Loss1 | Loss2 }
Softkeys
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Remote Control Commands

SENS:CORR:EXT:PORT:LDC

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LDC <loss>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LDC?

Sets or reads out the loss value at DC for the pbextension

Description function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5]6|7|8|9}
<Pt>=([1][2}
Parameter <loss> the loss value frome 200 to 200
Unit dB (decibel)

Out of Range

Sets the value of the limit, which is closer to the specifié value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Calibration > Port Extensions > Loss > Loss at DC
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Remote Control Commands

SENS:CORR:EXT:PORT:LOSS

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LOSS{[1]|2} <loss>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:LOSS{[1]| 2}?

Sets or reads out the values of the loss 1 and loss 2 for the port

Description extension function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5]6|7|8|9}
<Pt>={[1]|2}
Parameter <loss> the loss value frome 200 to 200
Unit dB (decibel)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Calibration > Port Extensions > Loss > { Loss1 | Loss2 }
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Remote Control Commands

SENS:CORR:EXT:PORT:TIME

SENSe<Ch>:CORRection :EXTension:PORT<Pt>:TIME <time>

SENSe<Ch>:CORRection:EXTension:PORT<Pt>:TIME?

Sets or reads out the electrical delay value for the port extension

Description function (command/query).
Port <Pt> of channel <Ch>,
Target <Ch>={[1]|2|3|4|5]6|7|8|9}
<Pe=([1]] 2}
Parameter <time> the electrical delay value frome 10 to 10
Unit s (second)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Calibration > Port Extensions> { Extension Portl | Extension Port2 }
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Remote Control Commands

SENS:CORR:IMP
SENSe:CORRection:IMPedance[:INPut][:MAGNitude] <impedance>

SENSe:CORRection:IMPedance[:INPut][:MAGNitude]?

Description Sets or reads out the system impedance Z0 (command/query)
Parameter <impedance> the Z0 value from 0.001 to 1000
Unit w ( Ohm)

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Respons¢ <numeric>

Preset Value 50

Equivalent

ot
Softkeys Calibration > System Z0
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Remote Control Commands

SENS:CORR:STAT
SENSe<Ch>:CORRection:STATe {ON|OFF|1|0}

SENSe<Ch>:CORRection :STATe?

Sets or reads out the ON/OFF state of the error correction

Description (command/query).
Target Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
{ON|1} Error correction ON
Parameter

{OFF|0} Error correction OFF

Query Responsg¢ {0]1}

Preset Value 0

Equvalent

i _
Softkeys Calibration > Correction
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Remote Control Commands

SENS:CORR: TRAN:TIME:FREQ

SENSe<Ch>:CORRection: TRANsform: TIME:FREQuency <frequency>

SENSe<Ch>:CORRection: TRANsform: TIME:FREQuency?

Sets or reads out the frequency value at which the cable loss
specified for the cable correction function, when the time domain

Description transformation function is turned ON.
(command/query)
Target Changel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <frequency> the frequency value.
Unit Hz (Hertz)
Query Response| <numeric>
Presetvalue 1 GHz
gg?tilz/eaﬁm Analysis > Time Domain > Cable Correction > Frequency
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Remote Control Commands

SENS:CORR: TRAN:TIMEBSS

SENSe<Ch>:CORRection:TRANsform:TIME: LOSS <numeric >

SENSe<Ch>:CORRection:TRANsform:TIME: LOSS

Sets or reads out the cable loss vale for the cable correction

Description function, when the time domain transformation function is turned
ON. (command/query)

Target <Cres{ll3lasI6I7IEe)

Parameter <numeric> the cable loss value.

Unit dB/m (decibell / meter)

Query Response| <numeric>

Preset Value 0dB/m

Equivalent
Softkeys

Analysis > Time Domain > Cable Correction > Cable Loss
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Remote Control Commands

SENS:CORR:TRAN:TIREZEL
SENSe<Ch>:CORRection:TRANsform:TIME:  RVELocity <numeric >

SENSe<Ch>:CORRection:TRANsform:TIME:  RVELocity ?

Sets or read out the cable relative wave speed velocity for the
cable correction function, when the time domain transformation

Description function is turned ON.
(command/query)
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
Parameter <numeric> the cable velocity factor.

Quay Response | <numeric>

Preset Value 1.0

Equivalent

Analysis > Time Domain > Cable Correction > Velocity Factor
Softkeys
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Remote Control Commands

SENS:CORR:TRAN:TIME:STAT
SENSe<Ch>:CORRection:TRANsform:TIME:STATe <bool>

SENSe<Ch>:CORRection:TRANsform:TIME:STATe?

Tums ON/OFF the cable correction when the time domain

Description transformation function is turned ON.(command/query)
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3]4/5|6]7|8|9}
Specifies state of the cable correction:
Parameter {ON|1} . ON

{OFF|0} . OFF

Query Response| { 0|1}

Preset Value 0

Equivalent

Analysis > Time Domain > Cable Correction > Cable Correction
Softkeys
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Remote Control Commands

SENS:CORR:TYPE?

SENSe<Ch>:CORRection:TYPE<Tr>?

- Reads out the applied calibration type and the port numbers for the
Description e
specified trace (query aly).
Trace <Tr> of channel <Ch>,
Target <Tr>={[1]|2|3|4|5|6|7|8}
<Ch>={[1]|2|3]4/5/6|7]8]9}
{RESPO|RESPS|RESPT|SOLT1|SOLT2|1PATH|NONE},
<srcport>,<rcvport>
Where:
RESPO : Response (Open)
RESPS : Response (Short)
RESPT : Response (Thu)
Query Responst
SOLT1 : Full 1 port calibration
1PATH : One path Z port calibration
NONE : Not defined
<rcvport>, the number of the receiver port from 1 to 2
<srcport>, the number of the source port =1
Equivalent
Softkeys None
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Remote Control Commands

SENS:FREQ

SENSe<Ch>:FREQuecy[:CW] <frequency>

SENSe<Ch>:FREQuency[:FIXed] <frequency>

SENSe<Ch>:FREQuency[:CW]?

SENSe<Ch>:FREQuency[:FIXed]?

Sets or reads out he fixed frequency for the power sweep

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}

<frequency> the CW frequency value

Paraneter from 3E5to 1.3E9 (Planaie TR1300/1),
from 2E4to 4.8E9 (TR5048),
from 2E4to 3.0E9 (TR7530).

Unit Hz (Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

6.5015E8 (Planare TR1300/1),
2.40001E9 (TR5048),
1.50001E9 (TR7530).

Equivalent
Softkeys

Stimulus > Power > CW Freq
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Remote Control Commands

SENS:FREQ:DATA?

SENSe<Ch>:FREQuency:DATA?

Reads out the array of the measurement points frequency (query

only).
The array size is N, where N is the number of measurement points.

Description .
P For the re th point, where n from 1 to N:
<numeric n> the frequency value at the re th measurement
point
Channel <Ch>,
Target

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<numeric 1>, < numeric 2>, é<numeric

The data transfer format depends on th&cORM:DATAcommand
setting.

Related FORM:DATA
Commands

Equivalent

Softkeys None
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Remote Control Commands

SENS:FREQENT

SENSe<Ch>:FREQuency:CENTer <frequency>

SENSe<Ch>:FREQuency:CENTer?

Sets or readsout the stimulus center value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<frequency> the stimulus center value
Parameter from 3E5to 1.3E9 (Planaie TR1300/1),
from 2E4to 4.8E9 (TR5048),
from 2E4to 3.0E9 (TR7530).
Unit Hz (Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons

<numeric>

Preset Value

6.5015E8 (Planar- TR1300/1),
2.40001E9 (TR5048),
1.50001E9 (TR7530)

Equinalent
Softkeys

Stimulus > Center
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Remote Control Commands

SENS:FREQ:SPAN

SENSe<Ch>:FREQuency:SPAN <frequency>

SENSe<Ch>:FREQuency:SPAN?

Sets or reads out the stimulus span value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Taroet Channel<Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<frequency> the stimulus span value
Parameter from O to 1.2997E9 (Planae TR1300/1),
from 0 to 4.79998E9 (TR5048),
from 0 to 2.99998E9 (TR7530).
Unit Hz (Hertz)

Out of Range

Sets the value of the limit, which is closerto the specified value.

Query Respons

<numeric>

Preset Value

1.2997E9 (Planare TR1300/1),
4.79998E9 (TR5048),
2.99998E9 (TR7530).

Equivalent
Softkeys

Stimulus > Span
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Remote Control Commands

SENS:FREQ:STAR

SENSe<Ch>:FREQuency:STARt <frequency>

SENSe<Ch>:FREQuency:STARt?

Sets or reads out the stimulus start value of the sweep range for

Degription linear or logarithmic sweep type (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<frequency> the stimulus start value
Parameter from 3E5 to 1.3E9 (Planae TR13001),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons

<numeric>

Preset Value

3ES5 (Planare TR1300/1),
2E4 (TR5048),
2E4 (TR7530).

Equivalent
Softkeys

Stimulus > Start
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Remote Control Commands

SENS:FRE@TOP

SENSe<Ch>:FREQuency:STOP <frequency>

SENSe<Ch>:FREQuency:STOP?

Sets or reads out the stimulus stop value of the sweep range for

Description linear or logarithmic sweep type (command/query).
Target Chamel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}
<frequency> the stimulus stop value
Parameter form 3E5 to 1.3E9 (Planae TR1300/1),
from 2E4 to 4.8E9 (TR5048),
from 2E4 to 3.0E9 (TR7530).
Unit Hz (Hertz)

Out of Range

Sets the value of the limit, which is closer b the specified value.

Query Respons

<numeric>

Preset Value

1.3E9 (Planare TR1300/1),
4.8E9 (TR5048),
3.0E9 (TR7530).

Equivalent
Softkeys

Stimulus > Stop
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Remote Control Commands

SENS:OFFS

SENSe<Ch>:0FFSet[:STATe] {ON|OFF|1|0}

SENSe<Ch>:0FFSet[:STATe]?

Sets or eads out the ON/OFF state of the frequencgffset feature

Description (command/query).
Target Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8|9}
{ON]1} frequency offset ON
Parameter
{OFF|0}  frequencyoffset OFF
Query Responsq {01}
Preset Value 0
Equivalent Stimulus > Freq. Offset > Fre¢Offset
Softkeys a

SENS:OFFS:ADJ

SENSe<Ch>:OFFSet:ADJust[:STATe] {ON|OFF|1|0}

SENSe<Ch>:0FFSet:ADJust[:STATe]?

Sets or reads out the ON/OFF state of the frequenayffset adjust

Description feature (command/query).
Target Channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}
{ON|1} frequency offset adjust ON
Parameter
{OFF|0} frequency offset adjust OFF
Query Respons¢ {0[1}
Preset Value 0
Equivalent Stimulus > Freq Offset > Offset Adjust > Offset Adjust
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:CONT

SENSe<Ch>:0FFSet:ADJust:CONTinuous[:STATe] {ON|OFF|1]0}

SENSe<Ch>:0FFSet:ADJust:CONTinuous[:STATe]?

Sets or reads out the ON/OFF state of theontinuous frequency

Descrption offset adjust feature (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3|4/5|6|7|8]|9}
{ON]|1} continuous frequency offset adjustON
Paraneter

{OFF|0}  continuous frequency offset adjustOFF

Query Respons¢ {0|1}

Preset Value |0

Equivalent Stimulus > Freq Offset > Offset Adjust > ContinAdjust
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:CONT:PER
SENSe<Ch>:0FFSet:ADJust:CONTinuous:PERiod <numeric>

SENSe<Ch>:0FFSet:ADJust:CONTinuous:PERiod ?

. Sets or reads out theperiod for continuous offset adjust feature
Descripion
(command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}
<numeric> the period for continuous offset adjust feature:
le 3sec,
2¢g 10 sec,
Parameter
3¢ 30 sec,
4¢ 100 sec,
5¢ 300 sec,
Unit n/a
Out of Range | Sets the value of the limit, which is closer to the specified value.
Query Respons{ <numeric>
Preset Value 3
Equivaént : . . :
Stimulus > Freq Offset > Offset Adjust > Adjust Period
Softkeys
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Remote Control Commans

SENS:OFFS:ADJ:EXEC

SENSe<Ch>:0FFSet:ADJust: EXECute

Executes theoffset adjust when the frequency offset feature is ON

Description (no query).
Channel <Ch>,
Target <Ch>={[1]|2|3]4|5|6| 718|9}
Equivalent Stimulus > Freq Offset > Offset Adjust > Adjust Immediate
Softkeys

227




Remote Control Commands

SENS:OFFS:ADJ:PORT
SENSe<Ch>:0FFSet:ADJust:PORT <numeric>

SENSe<Ch>:0FFSet:ADJust:PORT ?

- Sets or reads out theport number for frequency offset adjust featire
Description

(command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <numeric> port number 1 to 2;
Unit n/a

Out of Range | Sets the value of the limit, which is closer to the specified value.

Query Responsg¢ <numeric>

Preset Value 1

Equivalem

Stimulus > Freq Offset > Offset Adjust > Select Port
Softkeys
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Remote Control Commands

SENS:OFFS:ADJ:VAL

SENSe<Ch>:0FFSet:ADJust:VALue <hertz>

SENSe<Ch>:0FFSet:ADJust:VALue ?

Sets or reads out thefrequency offset adjust value of the offset

Description adjust feature (commandguery).
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3]4|5|6|7|8|9}
<hertz> adjust value of the offset adjust feature frome 5E5 to
Parameter
5E5;
Unit Hz

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>
Preset Value 0
Equivalent . . .
. Stimulus > Freq Offset > Offset Adjust > Adjust Value
Softkeys
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Remote Control Commands

SENS:OFFS:PORT:DATA?

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:DATA?

Reads out the array of the frequency points of port <Pt> when the
frequency offset feaure is ON and offset type is "PORT" (query only

Description The array size is N, where N is the number of measurement points.
For the re th point, where n from 1 to N:
<numeric n> the frequency value at the rg th point
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2]3] 4|5|6|7|8|9}

<Pt>={[1]|2}

Query Responst

<pnumeric 1>, <pumeric 2>, é<nu

The data transfer format depends on th&cORM:DATAcommand
setting.

FORM:DATA
Related SENS:OFFS:STAT
Commands | SENS:OFFS:TYPE
Equivalent
Softkeys None
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Remote Control Commands

SENS:OFFS:PORT:DIV

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:DIVisor <numeric>

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:DIVisor?

Sets or reads out thebasic frequency range divisoof port <Pt>

Description when the frequency offset feature is ON and offset type is "PORT"
(command/aquery).
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>=([1]j2}

Parameter <numeric> divisor from 1 to 1000;

Unit n/a

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Respons{ <numeric>

Preset Viue 1

Related SENS:OFFS:STAT

Commands SENS:OFFS: TYPE

Equivalent . .
Stimulus > Freq Offset > Port n > Divider

Softkeys
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Remote Control Cormands

SENS:OFFS:PORT:MULT

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:MULTiplier <numeric>

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:MULTiplier?

Sets or reads out thebasic frequency range multiplierof port <Pt>

Descrption when the frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>=([1]j2}

Parameter <numeric> multiplier from € 1000 to 1000;

Unit n/a

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Related SENS:OFFS:STAT

Commands SENS:OFFS:TYPE

Equivalent , o
Softkeys Stimulus > Freq Offset > Port n > Multiplier
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Remote Control Commands

SENS:OFFS:PORT:OFFS

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:OFFSet <hertz>

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:OFFSet?

Sets or reads out thebasic frequency range offsetf port <Pt> when

Descrption the frequency offset feature 8 ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>={[1]|2}

Parameter <hertz> offset from € 1el12 to 1el2;

Unit Hz

Out of Range

Sets the value of the limit, which is closer to the specified vhue.

Query Responst

<numeric>

Preset Value

Related SENS:OFFS:STAT

Commands SENS:OFFS:TYPE

Equivalent .

Softkeys Stimulus > FreqOffset > Port n > Offset
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Remote Control Commands

SENS:OFFS:PORT:STAR

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:STARt <hertz>

SENSe<Ch>:0FFSet:PORT<Pt >[:FREQuency]:STARt?

Sets or reads out thefrequency sweep startof port <Pt> when the

Description frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>={[1]|2}

Unit Hz

Query Responsg¢ <numeric>

Related SENS:OFFS:STAT
Commands SENS:OFFS:TYPE
Equivalent .
Stimulus > Freq Offset > Port n > Start
Softkeys
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Remote Control Commands

SENS:OFFS:PORT:STOP

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:STOP <hertz>

SENSe<Ch>:0FFSet:PORT<Pt>[:FREQuency]:STOP?

Sets or reads out thefrequency sweep stopof port <Pt> when the

Descriptin frequency offset feature is ON and offset type is "PORT"
(command/query).
Port <Pt> of channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}
<Pt>={[1]|2}

Unit Hz

Query Respons¢ <numer ic>

Related SENS:OFFS:STAT

Commands SENS:OFFS:TYPE

Equivalent Stimulus > FreqOffset > Port n > Sto
Softkeys P
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Remote Control Commands

SENS:ROSC:SOUR

SENSe<Ch>:ROSCillator:SOURce <char>

SENSe<Ch>:ROSCillator:SOURce?

Sets or reads out the internal or external soure of the reference

Description frequency of 10 MHz (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4]5|6|7|8|9}
<char> choose from:
Parameter INTernal : Internal source of the reference frequency
EXTernal : External source of the reference frequency
Out ofRange Error occurs. The command is ignored.
Query Respons¢ {INT|EXT}
Preset Value INT
Equivalent System > Misc Setup > Ref Source
Softkeys
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Remote ControlCommands

SENS:SEGM:DATA

SENSe<Ch>:SEGMent:DATA <numeric list>

SENSe<Ch>:SEGMent:DATA?

Sets or reads out thearray of the segment sweep table
(command/query).

The array has the following format:

{ <Buf>, <Flag1l>, <Flag2>, <Flag3>, <Flag4>,
<Flag5>, <N>,

<Start 1>, <Stop 1>, <NOP 1> [ <IFBW 1>] [,<Pow
1>] [,<Del 1>] [,<Time 1>],

<Start 2>, <Stop 2>, <NOP 2> [<IF BW 2>] [,<Pow

g>] [,<Del 2>] [,<Time 2>],

2StartN>, <StopN>, <NOP N> [,<IFBW N>] [ ,<Pow

N>] [,<Del N>] [,<TimeN>] }

<Buf> Always 5,

<Flag1> Stimulus start setting (O¢ start/stop, 1¢
center/span),

<Flag2> Setting of the <IFBW> field (& disabled,1 ¢

Description enabled),

<Flag3> Setting of the <Pow> field (Ot disabled, 1g
enabled),

<Flag4> Setting of the <Del> field (Ot disabled, 1¢ enabled),

<Flag5> Setting of the <Time> field (Os disabled, 1¢
enabled),

<N> Number of segments,

<Start n> Start value of the ne th segment,

<Stop n> Stop value of the re th segment,

<NOP n> Number of points of the re th segment,

<IFBW n> IF bandwidth of the ne th segment (if enabled),

<Pow n> Power of the re th segment (if enabled),

<Del n> Measurement delay 6éthe ne th segment (if enabled),

<Time n> Reserved for future use (if enabled)

Target Channel <Ch>,

<Ch>={[1]|2/31415/6/7|8]9)

Query Respons

<pumeric 1>, <numeric 2>, é<nume

Where,
N ¢ the number of the segments,

M ¢ depends on the values othe flags
M = 3 + <Flag2> + <Flag3> + <Flag4> + <Flag5>

Equivalent

Softkeys

Stimulus > Segment Table
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Remote Control Commands

SENS:SWE:POIN
SENSe<Ch>:SWEep:POINts <numeric>

SENSe<Ch>:SWEep:POINts?

Sets or reads out the number of measurement points

Description (command/query).
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3]4/5|6|7|8|9}
<numeric> the number of measurement points
from 2 to 16001 (Planare TR1300/1),
Parameter

from 2 to 100001 (TR5048),
from 2 to 100001 (TR7530).

Out of Range | Sets the value of the limit, which is closer tothe specified value.

Query Responsg¢ <numeric>

Preset Value 201

Equivalent

) > Po
Softkeys Stimulus > Points
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Remote Control Commands

SENSSWE:POIN:TIME
SENSe<Ch>:SWEep:POINt:TIME <time>

SENSe<Ch>:SWEep:POINt:TIME?

Sets or reads out the delay before measurement in each

Description measurement point (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <time> the measurement delay value fronD to 0.3
Resolution 5E 6
Unit s (second)

Out of Range | Sets the value of the limit, which is closer to the specified vale.

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

i >
Softkeys Stimulus > Meas Delay
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Remote Control Commands

SENS:SWE:TYPE

SENSe<Ch>:SWEep:TYPE <char>

SENSe<Ch>:SWEep:TYPE?

Description

Sets or reads out the sweep type (command/query).

Target

Channel <Ch>,
<Ch>={[1]|2|3]4|5| 6/7|89}

Parameter

<char> specifies the sweep type:
LINear : Linear frequency sweep

LOGarithmic  : Logarithmic frequency sweep

SEGMent : Segment frequency sweep
POWer - Power sweep
VVM : Vector Voltmeter mode

Out of Range

Error occurs. Theeommand is ignored.

Query Responst

{LIN|LOG|SEGM|POW}

Preset Value

LIN

Equivalent
Softkeys

Stimulus > Sweep Type
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Remote Control Commands

SENS/VMTYPE

SENSeCh>:VVM:TYPE <char>

SENSeCh>VVM:TYPE?

Sets or reads out the measured parametetin Vector Voltmeter

Description mode.
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3|4/5|6|7|8|9}

<char> choose from:
S11 : Reflection parameter
S21 : Transmission parameter

Parameter . . .
AJB : The ratio of the receivers signals A to B, an

external frequency generator is used.

: The ratio of the receivers signals B to A, an

B/A .
external frequency generator is used.

Out of Range

Error occurs. The command is ignored.

Query Responst

{S11| S21|A/B|B/A }

Preset Value

S11

Equivalent

Softkeys

Stimulus >Vector Voltmeter > Measurement> {S11|S21|A/B|RA}
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Remote Corrol Commands

SENS/VMFORM

SENSeCh>:VVM:FORMat <char>

SENSeCh>:VVM:FORMat?

Description

Sets or reads outhe data format in Vector Voltmeter mode.

Target

Channel <Ch>,
<Ch>={[1]|2|3|4/5|6|7|8|9}

Parameter

<char> choose from:

LOGP : Log magnitude and phase
LINP : Linear magnitude and phase
SWR : Voltage standing wave ratio

IMP : Impedance value

Out of Range

Error occurs. The command is ignored.

Query Responst

{LOGP| LINP|SWR|IMP }

Preset Value

LOGP

Equivalent
Softkeys

Stimulus >Vector Voltmeter > Format > {LOGP| LINP| SWR| IMP}
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Remote Control Commands

SENS/VMFREQ
SENSe<Ch>:VVMFREQuency [:CW] <numeric >

SENSe<Ch>:VVMFREQuency [:CW]?

Sets or reads out the operating frequency in the Vector

Description Voltmeter mode.

Target Changel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}

Paraneter <numeric > the frequency value.

Unit Hz (Hertz)

Query Response| <numeric>

Equivalent

i > >
Softkeys Stimulus >Vector Voltmeter > Frequency
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SENS/VMDATA?

SENSe<Ch>: VVM DATA?

Reads out the value of the vector voltmeter measurement (query
only). If a reference value is specified, the return value is read
relatively to it.

The data include 2 elements:

Description _
<numeric 1> Magnitude value, depending on the data
format or SWRvalue;
<numeric 2> Phase value or zero in SWR format
Target Channel <Ch>,

<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Responst

<numeric 1>, <numeric 2>

SENSe<Ch>:VVM:FORMat

Related SENSe<Ch>:VVM:REFerence:MEMorize
Commands SENSe<Ch>:VVM:REFerence: CLEar
Equivalent

Softkeys None

SENS/VMREF:CLE

SENSeCh>: VVM REFerence:CLEar

Description Clears the reference value of the vector voltmeter .
Taroet Channel <Ch>,

9 <Ch>={[1]2]3]4/5|6|7|8]9}
Equivalent Stimulus >Vector Voltmeter > Clear Reference
Softkeys
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Remote Control Commands

SENS/VMREF:MEM

SENSeCh>: VVM REFerence:MEMorize

Description Memorizes the referencevalue of the vector voltmeter .

Channel <Ch>,

Target <Ch>={[1]|2]3|4|5|6|7|8|9}
Equivalent Stimulus >Vector Voltmeter > Save Reference
Softkeys

SENS/VMREF:DATA?

SENSeCh>: VVM REFerence:DATA ?

Reads out thereferencevalue of the vector vdtmeter measurement

(query only).
The data include 2 elements:

Description <numeric 1> Magnitude value, depending on the data
format or SWR value;

<numeric 2> Phase value or zero in SWR format.

Channel <Ch>,

Target <Ch>={[1]|2]3|4/5|6|7|8]|9}

Query Respons¢ <numeric 1>, <numeric 2>

Related SENSe<Ch>:VVM:FORMat
SENSe<Ch>:VVM:REFerence:MEMorize
Commands SENSe<Ch>:VVM:REFerence: CLEar

Equivalent

Softkeys None
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SENS/VMTABL:CLE

SENSeCh>: VVM TABLe:CLEar

Clears all data from the vector voltmeter measuremant

Description
P table.
Taroet Channel <Ch>,
9 <Ch>={[1]|2]3]4/5|6]7|8|9}
Related SENSe<Ch>:VVM:TABLe:MEMorize
SENSe<Ch>:VVM:TABLe: INSert
Commands SENSe<Ch>:VVM:TABLe:REMove
Equivalent Stimulus >Vector Voltmeter > Data Table> Clear Table
Softkeys

SENS/VMTABL:MEM

SENSeCh>: VVM TABLe:MEMorize

Description Saves measurements of the vector voltmeter to the table.
Taroet Channel <Ch>,
9 <Ch>={[1]2]3]4/5|6|7|8]9}

Related SENSe<Ch>:VVM:TABLe:MEMorize
SENSe<Ch>:VVM:TABLe: INSert

Commands SENSe<Ch>:VVM:TABLe:REMove

Equivaént .
Stimulus >Vector Voltmeter > Data Table> Add Data

Softkeys
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Remote Control Commands

SENS/VMTABL:INS

SENSeCh>: VVM TABLe:MEMorize

Inserts a row of data into the table with the current
measurement of a vector voltmeter

Description
<numeric> The row number in the table where new
data will be inserted.
Channel <Ch>,
Target <Ch>={[1]|2/3|4|5/6/7|8]9}
Related SENSe<Ch>:VVM:TABLe:MEMorize
SENSe<Ch>:VVM:TABLe: INSert
Commands SENSe<Ch>:VVM:TABLe:REMove
Equivalent Stimulus >Vector Voltmeter > Data Table> Insert Data
Softkeys

SENS/VMTABL:REM

SENSe&Ch>: VVM TABLe:REMove <numeric>

Removes a table row with a vector voltmeter measurement
index

Description

<numeric> The row number in the table which will be
removed.
Taroet Channel <Ch>,
9 <Ch>={[1]|2|3|4|5|6|7|8|9}

Related SENSe<Ch>:VVM:TABLe: CLEar
SENSe<Ch>:VVM:TABLe: MEMorize

Comnands SENSe<Ch>:VVM:TABLe: INSert

Equival )

quivalent Stimulus >Vector Voltmeter > Data Table> Remove Data
Softkeys
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SENS:VVM:TABL:SAVE

SENSeCh>: VVM TABLe:SAVE <string>

Description Saves thetable into CSV fie.

Channel <Ch>,

Target <Ch>={[1]|2|3|4|5|6|7|8|9}

Parameter <string> File name (quoted string)

If the full path of the file is not specified, the \CSV subdirectory of
Notes the main directory will be searched for the file.The file has *.csv
extension by default.

Equivalent

Stimulus >Vector Voltmeter > Data Table> Save Table to CSV
Softkeys
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SENS/VMTABL:DATA?

SENSe<Ch>: VVM TABLe:DATA

Returns data table of the vector voltmeter query only).
The array has the following format:

{<Flagl> <N>,

<Abs.Mag 1>, <Abs.Phase 1> [,<Rel.Mag 1>] [,<Rel.Phase 1>],
h

<Abs.Mag N>, <Abs.Phase N> [,<Rel.Mag N>] [,<Rel.Phase N>]}

Description Where:
<Flagl> reference value, @ is not specified, 1¢ is specified,
N € rows number in the data table;
<Abs.Mag i>, <AbBhase i>- measurement data of a vector
voltmeter;
[[<Rel.Mag i>] [,<Rel.Phase i>measurement data relative to the
reference value (if specified).
Channel <Ch>,
Target <Ch>={[1]|2[3|4/5/6|7/8]9}
<numeric 1>, <numeri c 22NP(RQE€M2Y) B m
R Where:
QueryResponse N € number of table rows,
M ¢ flag value Flagl
SENSe<Ch>:VVM:TABLe: CLEar
Related SENSe<Ch>:VVM:TABLe: MEMorize
Commands SENSe<Ch>:VVM:TABLe: REMove
SENSe<Ch>:VVM:TABLe: INSert
Equivalent
Softkeys None
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SERV:CHAN:ACT?

SERVice:CHANnNel:ACTive?

Remote Control Commands

Description Reads out the active channel number (query only).

Query Responsg <numeric> from 1to 16

Equivalent

Softkeys None

SERV:CHAN:COUN?

SERVice:CHANnel:COUNt?

Description Reads out the maximum number of the channels (query only).

Query Respons{ <numeric>

Equivalent

Softkeys None

SERV:CHAN:TRAC:ACT?

SERVice:CHANnNel<Ch>:TRACe:ACTive?

Description Read out the active trace number of the channel (query only).

Channel <Ch>,

Target <Ch>={[1]|2|3/4/5|6|7|8|9}

Query Respons¢ <numeric> from 1to 16

Equvalent

Softkeys None
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Remote Control Commands

SERV:CHAN:TRAC:COUN?

SERVice:CHANnel: TRACe:COUNt?

Description

Reads out the maximum number of the traces in the channel (query
only).

Query Responsg¢ <numeric>
Equivalent
Softkeys None

SERV:PORT:COUN?

SERVice:PORT:COUNt?

Descriptim

Reads out the number of the ports (query only).

Query Responsg¢ <numeric>
Equivalent
Softkeys None

SERV:SWE:FREQ:MAX?

SERVice:SWEep:FREQuency:MAXimum?

Description

Reads out the upper limit of the measurement frequency (query
only).

Query Respons{ <numeric>
Unit Hz (Hertz)
Equivalent

Softkeys None

251



Remote Control Commands

SERV:SWE:FREQ:MIN?

SERVice:SWEep:FREQuency:MINimum?

Reads out the lower frequency of the measurement frequency

Description (query only).

Query Responsg¢ <numeric>

Unit Hz (Hertz)
Equivalent
Softkeys None

SERV:SWE:POIN?

SERVice:SWEep:POINts?

Reads out the maximum number of the measurement points (query

Description only).

Query Respons{ <numeric>

Equivalent

Softkeys None
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SOUR:POW

SOURce<Ch>:POWer[:LEVel][:IMMediate][:AMPLitude] <power>

SOURce<Ch>:POWer[:LEVel][:IMMediate][:AMPLitude]?

Sets or reads out the power level for the frequency sweep

Description (command/query).

Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}

Parameter <power> the power level from ¢ 55 to +3

Resolution 0.05

Unit dBm (decibelsabove 1 milliwatt)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Stimulus > Power > Outut Power
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Remote Control Commands

SOUR:POW:CENT

SOURce<Ch>:POWer:CENTer <power>

SOURce<Ch>:POWer:CENTer?

Sets or reads out the center value of the power sweep range

Description (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <power> the power sweep center value frome 55 to +3
Resolution 0.025
Unit dBm (decibels abore 1 milliwatt)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

1225

Equivalent
Softkeys

Stimulus > Center
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Remote Control Commands

SOUR:POW:SLOP

SOURce<Ch>:POWer[:LEVel]:SLOP¢e[:DATA] <power>

SOURce<Ch=POWer[:LEVel]:SLOPe[:DATA]?

Sets or reads out the power slope value for the frequency sweep

Description (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <power> the power slope value frome 2 to +2
Resolution 0.1
Unit dB/GHz (lecibel/gigahertz)

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Stimulus > Power >Power Slope [dB/GHZ]
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Remote Control Commands

SOUR:POW:SPAN

SOURce<Ch>:POWer:SPAN <power>

SOURe<Ch>:POWer:SPAN?

Sets or reads out the power span for the power sweep

Description (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <power> the power sweep span value from 0 to 58
Resolution 0.05
Unit dBm (decibels above 1 nilliwatt )

Out of Range

Sets the value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

58

Equivalent
Softkeys

Stimulus > Span
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SOUR:POW:STAR

SOURce<Ch>:POWer:STARt <power>

SOURce<Ch>:POWer:STARt?

Sets or reads out the power sweep start for the power sweep

Description (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <power> the power sweep start frome 55 to +3
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)

Out of Range

Setsthe value of the limit, which is closer to the specified value.

Query Responst

<numeric>

Preset Value

155

Equivalent
Softkeys

Stimulus > Start

257
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SOUR:POW:STOP

SOURce<Ch>:POWer:STOP <power>

SOURce<Ch>:POWer:STOP?

Sets or reads out the powesweep stop for the power sweep

Description (command/query).
Target Chanrlel <Ch>,
<Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <power> the power sweep stop frome 55 to +3
Resolution 0.05
Unit dBm (decibels above 1 milliwatt)

Out of Range

Sets the value of the limit, whichis closer to the specified value.

Query Responst

<numeric>

Preset Value

Equivalent
Softkeys

Stimulus > Stop
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STAT:OPER?

STATus:OPERation[:EVEN(]?

Reads out the value of the Operation Status Event Register (query

D ipti
escription only).

Target Status Reprting System

Query Responsg¢ <numeric>

Equivalent

Softkeys None

STAT:OPER:COND?

STATus:OPERation:CONDition?

Reads out the value of the Operation Status Condition Register

Description (query only).

Target Status Reporting System

Query Responsq <numeric >

Equivalent

Softkeys None
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Remote Control Commands

STAT:OPER:ENAB

STATus:OPERation:ENABle <numeric>

STATus:OPERation:ENABIle?

Sets or reads out the value of the Operation Status Enable Register

Description (command/query).

Target Status Reporting System
Parameter <numeric> from 0 to 65535

Out of Range | Bite tog bit AND with numeric 65535
Query Responsg¢ <numeric>

Preset Value |0

S e
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Remote Control Commands

STAT:OPER:NTR

STATus:OPERation:NTRansition <numeric>

STATus:OPERation:NTRansition?

Sets or reads out the value bthe Negative transition filter of the

Description Operation Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range | Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

Sdtkeys None
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Remote Control Commands

STAT:OPER:PTR

STATus:OPERation:PTRansition <numeric>

STATus:OPERation:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Operation Status Register (command/query).
Target Status Reporting System
Paameter <numeric> from O to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Responst

<numeric>

Preset Value

65535

Equivalent
Softkeys

None

STAT:PRES

STATus:PRESet

Description Resets all the status registers to the factory settings (no qug).
Target Status Reporting System

Query Responsg¢ <numeric>

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:COND?

STATus:QUEStionable:CONDition?

Reads out the value of the Questionable Status Condition Register

Description (query only).

Target Status Reporting §stem

Query Responsg¢ <numeric>

Equivalent

Softkeys None

STAT:QUES:ENAB
STATus:QUEStionable:ENABIe <numeric>

STATus:QUEStionable:ENABIle?

Sets or reads out the value of the Questionable Status Enable

Description Register (command/query).
Target Status Reorting System
Parameter <numeric> from 0 to 65535

Out of Range | Bite toe bit AND with numeric 65535

Query Respons{ <numeric>

Preset Value 0

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:LIM:CHAN:COND?

STATus:QUEStionable:LIMit:CHANnel<Ch>:CONDition?

Description

Reads out the value of the Questionable Limit Channel Status
Condition Register (query only).

Target

Channel <Ch>,
<Ch>={[1]|23]4|5|6|7|8]9}

Query Respons¢ <numeric>
Equivalent
Softkeys None

STAT:QUES:LIM:CHAN:ENAB

STATus:QUEStionable:LIMit: CHANnel<Ch

>:ENABIle <numeric>

STATus:QUEStionable:LIMit:CHANnel<Ch>:ENABIe?

Sets or reads out the value of the Questionable Limit Channel Statu

Description Enable Register (command/query).
Taroet Channel <Ch>,

9 <Ch>={[1]|2]3|4|5|6|7|8]|9}
Parameter <numeric> from 0 to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Respons{ <numeric>
Preset Value 0
Equivalent

N
Softkeys one
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Remote Control Commands

STAT:QUES:LIM:CHAN:NTR
STATus:QUEStionable:LIMit: CHANnel<Ch>:NTRansition <numeric>

STATus:QUEStionable:LIMit:CHANnel<Ch>:NTRansit ion?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Limit Channel Status Register (command/query).
Taroet Channel <Ch>,

9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <numeric> from O to 65535

Out of Range | Bite toe bit AND with numeric 65535

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:LIM:CHAN:PTR

STATus:QUEStionable:LIMit: CHANnel<Ch>:PTRansition <numeric>

STATus:QUEStionable:LIMit:CHANnel<Ch>:PTRansition?

Sets or reads otithe value of the Positive transition filter of the

Description Questionable Limit Channel Status Register (command/query).
Taroet Channel <Ch>,

9 <Ch>={[1]|2|3]4|5|6|7|8|9}
Parameter <numeric> from O to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Reponse | <numeric>
Preset Value 65535
Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:LIM:CHAN?

STATus:QUEStionable:LIMit: CHANnel<Ch>[:EVENT{]?

Description

Reads out the value of the Questionable Limit Channel Status Even
Register (query only).

Target

Channel <Ch>,
<Ch>={[1]|23]4|5|6|7|8]9}

Query Respons¢ <numeric>
Equivalent
Softkeys None

STAT:QUES:LIM:COND?

STATus:QUEStionable:LIMit:CONDition?

Reads out the value of the Questionable Limit Status Condition

Description Register (query only).
Target Status Reporing System
Query Respons{ <numeric>

Equivalent

Softkeys None
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STAT:QUES:LIM:ENAB
STATus:QUEStionable:LIMit:ENABle <numeric>

STATus:QUEStionable:LIMit:ENABIle?

Sets or reads out the value of the Questionable Limit Status Enable

Description Register (commad/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range | Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

Softkeys None

268



Remote Control Commands

STAT.:QUES.LIM:NTR
STATus:QUEStionable:LIMit:NTRansition <n umeric>

STATus:QUEStionable:LIMit:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out ofRange Bite toe bit AND with numeric 65535

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

Softkeys None
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STAT:QUES:LIM:PTR

STATus:QUEStionable:LIMit:PTRansition <numeric>

STATus:QUEStionable:LIMit:PTRansition?

Sets or reads out the valueof the Positive transition filter of the

Description Questionable Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>
Preset Value 65535
Equivalent

Softkeys None

STAT:QUES:LIM?

STATus:QUEStionable:LIMit[:EVENt]?

Reads out the value of the Questionable Limit Status Event Registe

Description (query only).

Target Status Reporting System
Query Respons{ <numeric>

Equivalent

Softkeys None
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STAT:QUES:NTR
STATus:QUEStionable:NTRansition <numeric>

STATus:QUEStionable:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Status Register (command/query).
Target Status Reporting System
Paraméer <numeric> from O to 65535

Out of Range | Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>

Preset Value 0

Equivalent

Softkeys None
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STAT.:QUES:PTR
STATus:QUEStionable:PTRansition <numeric>

STATus:QUEStionable:PTRansition?

Sets orreads out the value of the Positive transition filter of the

Description Questionable Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range | Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>

Prest Value 65535

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:RLIM:CHAN:COND?

STATus:QUEStionable:RLIMit:CHANnel<Ch>:CONDition?

Description

Reads out the value of the Questionable Ripple Limit Channel
Status Condition Register (query only).

Target

Channel <Ch>,
<Ch>={[1]|2|3|4|5|6|7|8|9}

Query Respons¢ <numeric>
Equivalent
Softkeys None

STAT:QUES:RLIM:CHAN:ENAB

STATus:QUEStionable:RLIMit: CHANnel<Ch>:ENABIle <numeric>

STATus:QUEStionable:RLIMit: CHANnel<Ch>:ENABIle?

Sets or reads out the value of the Qu&tionable Ripple Limit

Description Channel Status Enable Register (command/query).
Taroet Channel <Ch>,

9 <Ch>={[1]|2]3|4|5|6|7|8]|9}
Parameter <numeric> from 0 to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Respons{ <numeric>
Preset Value 0
Equivalet

N
Softkeys one
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Remote Control Commands

STAT:QUES:RLIM:CHAN:NTR

STATus:QUEStionable:RLIMit:CHANnel<Ch>:NTRansition <numeric>

STATus:QUEStionable:RLIMit:CHANnel<Ch>:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable RippleLimit Channel Status Register
(command/query).
Channel <Ch>,

Target <Ch>={[1]|2/3]4/5/6|7/8]9}

Parameter <numeric> from 0 to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Respons{ <numeric>
Preset Value |0
Equivalent

Softkeys None
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Remote Control Commands

STATQUES:RLIM:CHAN:PTR

STATus:QUEStionable:RLIMit:CHANnel<Ch>:PTRansition <numeric>

STATus:QUEStionable:RLIMit:CHANnel<Ch>:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questionable Ripple Limit Channel Status &yister
(command/query).
Channel <Ch>,

Target <Ch>={[1]]2/3]4/5/6|7|8]9}

Parameter <numeric> from 0 to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Respons{ <numeric>
Preset Value 65535
Equivalent

Softkeys None

STAT:QUES:RLIM:CHAN?

STATus:QUEStionable:RLIMit: CHANnel<Ch>[:EVEN{]?

Description

Reads out the value of the Questionable Ripple Limit Channel
Status Event Register (query only).

Target

Channel <Ch>,
<Ch>={[1]|2|3]4/5/67|8|9}

Query Respons{ <numeric>
Equivalent

N
Softkeys one
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Remote Control Cormands

STAT:QUES:RLIM:COND?

STATus:QUEStionable:RLIMit:CONDition?

Reads out the value of the Questionable Ripple Limit Status

D ipti . .

escription Condition Register (query only).
Target Status Reporting System
Query Responsg¢ <numeric>
Equivalent
Softkeys None

STAT:QES:RLIM:ENAB

STATus:QUEStionable:RLIMit:ENABIe <numeric>

STATus:QUEStionable:RLIMit:ENABIle?

Sets or reads out the value of the Questionable Ripple Limit Status

Description Enable Register (command/query).
Target Status Reporting System
Parameter <numeric > from 0 to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Respons{ <numeric>
Preset Value 0
Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:RLIM:NTR
STATus:QUEStionable:RLIMit:NTRansition <numeric>

STATus:QUEStionable:RLIMit:NTRansition?

Sets or reads out the value of the Negative transition filter of the

Description Questionable Ripple Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range | Bite tog bit AND with numeric 65535

Query Regpnse | <numeric>

Preset Value 0

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES:RLIM:PTR

STATus:QUEStionable:RLIMit:PTRansition <numeric>

STATus:QUEStionable:RLIMit:PTRansition?

Sets or reads out the value of the Positive transition filter of the

Description Questiomble Ripple Limit Status Register (command/query).
Target Status Reporting System
Parameter <numeric> from O to 65535

Out of Range

Bite tog bit AND with numeric 65535

Query Responsg¢ <numeric>
Preset Value 65535
Equivalent

Softkeys None

STAT:QUES:RLIM?

STATus:QUEStionable:RLIMIit[:EVEN{]?

Reads out the value of the Questionable Ripple Limit Status Event

Description Register (query only).
Target Status Reporting System
Query Respons{ <numeric>

Equivalent

Softkeys None
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Remote Control Commands

STAT:QUES?

STATus:QUEStionable: EVENTt]?

Reads out the value of the Questionable Status Event Register

D ipti
escription (query only).
Target Status Reporting System
Query Responsg¢ <numeric>
Equivalent
Softkeys None

SYST:COMM:ECAL:TEMP:SENS?

SYSTem:COMMunicate:ECAL: TEMPerature:SENSor?

Reads out the temperature of the AutoCal module connected to

Deseiption the Analyzer.(query only)
Target AutoCal module
Unit °C

Query Response

<numeric>

Equivalent
Softkeys

None
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Remote Control Commands

SYST:CORR

SYSTem:CORRection[:STATe] {ON|OFF|1]|0}

SYSTem:CORRection[:STATe ]?

Description

Sets or reads out the ON/OFF state of the system error correction
(command/query).

Parameter

{ON]1} System error correction ON

{OFF|0}  System error correction OFF

Query Responst

{011}

Preset Value

1

Equivalent
Softkeys

System > Misc Seip > System Correction

SYST:DATE

SYSTem:DATE <numeric 1>,<numeric 2>,<numeric 3>

SYSTem:DATE?

Description Sets or reads out the current date (command/query).
<numeric 1> year from 1900 to 2100;
Parameter <numeric 2> month from 1 to 12;
<numeric 3> day from 1 to 31.

Query Respons

<numeric 1>, <numeric 2>, <numeric 3>

Equivalent

Softkeys

None
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Remote ControlCommands

SYST:ERR?

SYSTem:ERRor[:NEXT]?

Description

Reads out the error message of the error occurred when executing
the SCPI commands, from the FIFO (First In FitSut) error queue
stored in the instrument. The read out error is deleted from the errol
gueue. The *CLS command clears the error queue. The maximum
size of the queue is 100 messages (query only).

Query Responst

<numeric>, <string>

Where:
<numeric> error code
<string> error message

If there is no error in the queue, "0, No error” is read out.

Equivalent
Softkeys None
SYST.LOC

SYSTem:LOCal

Sets the instrument to the local operation mode, when all the keys

Description on the front panel, mouse and tle touch screen are active (no
query).

Related SYST:REM

Commands SYST:RWL

Equivalent

Softkeys None
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SYST:PRES
SYSTem:PRESet
Description Resets the instrument to the factory settings (no query).
The difference from theRST.command is that the trigger is set to
Notes : .
the Continuous trigger mode.
Related *RST
Commands
Equivalent
Softkeys System > Preset Apply
SYSTREADy?

SYSTem:READY[:STATe]?

Reads out the ready state of the Analyzer. The state iuewhen
analyzer hardware is connectedpowered and the boot process is
completed (about 10 sec).

(query only)

Description

Query Response| {0[1}

Equivalent

Softkeys None
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SYST:REM

SYSTem:REMote

Sets the instrument to the remote operation mode, when all the
keys on the front panel, mouse andHhe touch screen are not active,

Description except for one key labeled Return to Local. Pushing this button will
reset the instrument to the local operation mode (no query).
Related SYST:LOC

Commands SYST:RWL

Equivalent

Softkeys None
SYST:RWL
SYSTem:RWLock
Sets the instrument to the remote operation mode, when all the
Descrinion keys on the front panel, mouse and the touch screen are not
P active. OnlySYST:LOCor SYST:REMcommand can release this
remote operation mode (no query).
Related SYST:LOC
Commands SYST:REM
Equivalent
Softkeys None
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SYST:TEMP:SENS?

SYSTem:TEMPerature:SENSor? <numeric>

Reads out the specified sensor temperature inside the Analyzer.

Description (query only)

Target Analyzer

Parameter <numeric> : Sensor number
Unit °C

Query Response| <numeri c>

Equivalent

Softkeys None
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SYST: TIME
SYSTem:TIME <numeric 1>,<numeric 2>,<numeric 3>

SYSTem:TIME?

Description Sets or reads out the current time (command/query).
<numeric 1> hours from 0 to 23;
Parameter <numeric 2> minutes from O to 59;

<numeric 3> seconds from 0 to 59.

Query Respons¢ <numeric 1>, <numeric 2>, <numeric 3>

Equivalent
Softkeys None
SYSTIERM
SYSTem:TERMinate
Terminates the analyzer software.
Description
(no query)
Equivalent .
>
Softkeys System > Exit Ok

285



TRIG
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TRIGger[:SEQuenc e][:IMMediate]

Generates a trigger, independently of the trigger source setting
(except for the Externa). If the trigger source is set toExterna) an
error occursand the command is ignored.

If the instrument is not in the waiting for a trigg er state (sweep is in

D -
escription progress or all the channels are set tdHold), an error occursand the
command is ignored.
The command is completed before the end of the sweep.
(no query)
TRIG:SOUR
Related INIT:CONT
Commands | |NIT:IMM
Equivalent
Softkeys None
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TRIG:SING

TRIGger[:SEQuence]:SINGle

Generates a trigger, independently of the trigger source setting
(except for the External). If the trigger source is set texterna) an
error occursand the command is ignored.

If the instrument is not in the waiting for a trigger state (sweep is in

Description progress or all the channels are set tddold), an error occursand the
command is ignored.
The command is not completed before the end of the sweep
(waiting for the completion of the sweep of all the channels).
(no query)
TRIG:SOUR

Related INIT:CONT

Commands | |NIT:IMM

Equivalent

Softkeys None
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TRIG:SOUR
TRIGger[:SEQuence]:SOURce <char>

TRIGger[:SEQuence]:SOURce?

Description Sets or reads out the sweep trigger source (command/query).

<char> choose fram:

INTernal > Internal
Parameter EXTernal : External

MANual : Manual

BUS :Bus

Out of Range | Error occurs. The command is ignored.

Query Respons¢ {INT|[EXT|MAN|BUS}

Preset Value INT

TRIG
Related TRIG:SING
Commands *TRG
Equivalent . . .
Softkeys Stimulus > Trigger > Trigger Source > {Internal | External | Bus }
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TRIGSTAT?
TRIGger[:SEQuence]:  STATus?
- Reads out the the current state of the analyzer.
Description
(query only)
HOLD scanning is stopped
Parameter MEASure is scanning
WAIT iS scanning
Equivalent
Softkeys None
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TRIG:WAIT

TRIGger[:SEQuence]: WAIT <char>

Delays the execution by theanalyzerof the next command till the
specified state of the analyzer has been reached (see options
below).

A query that follows the TRIG:WAIT command blocks the
execution of the user program till the specified state of the analyzer
has been reached.

Description The command can be used to wait for the end of the sweep
initianed by the commandsTRIG, *T RGor initiated by the
external trigger signal. If the continuous initiation modds turned ON
by the commandINIT:CONT ON, then the parameter of the
command must be WAIT, otherwise HOLD.

(no query)
<char> choose from:
HOLD : Waits for the Hold state

Parameter
MEASure : Waits for the Measurestate
WAIT : Waits for the Trigger Waitingstate

Related TRIG, *TRG

Commands TRIG:SOUR EXT

Equivalent

Softkeys None
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VVM:RES

VVMI:DISPlay]:RESolution <numeric>

VVM[:DISPlay]:RESolution ?

Description

Sets or reads outhumber of indication symbols in the vector
voltmeter mode

Parameter

Number of significant symbols from 3 to 12

Query Responst

<numeric>

Preset value

Equivalent Stimulus > Vector Voltmeter > Properties > Response Digits
Softkeys
VVM:FONT
VVM[:DISPlay]: FONT[:SIZE] <numeric>
VVM[:DISPlay]: FONT[:SIZE]?

Description

Sets or reads out the font size for indication in the vector
voltmeter mode

Parameter

Font size from 3 to 12

Query Responst

<numeric>

Preset value

36

Equivalent
Softkeys

Stimulus > Vector Voltmeter > Properties> Font Size
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5 Programming Tps

This section gives recommendations for programming in certain specific
situations.

5.1 Program Sweep Initiation and Waiting

The program sweep initiation and waiting forits completion the most simple
method can be implemented by usig commandsTRIG:SING and *OPC?. The
command TRIG:SING gerates a trigger sigha and starts sweeping under the
following conditions:

1 The program trigger source is selected by comman@RIG:SOUR BUS;

1 The analyzer should be in thetrigger waitingstate, otherwise (theanalyzer is
sweeping or analyzer is in theHold state) an error occursand the command
is ignored.

The transition of the analyzer to thetrigger waitingstate depends on the state of
the continuous initiation modewhich is set by commandINIT:CONT . Provided
that the continuous initiation modeis ON, the analyzer automatically transits to
the trigger waiting state when the program trigger source have been selected,
and then each time at the end of a sweep. Provided that theontinuous initiation
modeis OFF, the analyzer fansits to the trigger waiting state for single time
upon receiving the command INIT.

The commandTRIG:SING remains pending until the end of sweep. This allows
usethe *OPC? query for the waiting the end of sweep.

Example 1 Start sweeping in all channelsand waits for its completion. The
channels sweep one by one in turn. Theontinuous initiation modes enabled by
default.

TRIG:SOUR BUS Selects the program trigger source and puts
the analyzer to thetrigger waitingstate

<loop>:
TRIG:SING Starts sweep

*OPC? Waits for the end of the sweep

After the sweep completion the analyser returns to therigger waitingstate, and
then the next sweep initiation command can be sended.
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Example 2. Start sweeping in one channel and waitsfor its completion, then
start sweeping in another channel and waits for itscompletion. The channel
number must be set to 2.

TRIG:SOUR BUS Selects the program trigger source
INITL:CONT OFF Puts channel 1 to the hold state
INIT2:CONT OFF Puts channel 2 to the hold state

<loop>:
INIT1 Puts channel 1 to the trigger waiting state
TRIG:SING Starts sweep in channel 1
*OPC? Waits for the end of the sweep
INIT2 Puts channel 2 to the trigger waiting state
TRIG:SING Starts sweep in channel 2
*OPC? Waits for the end of the sweep

After completion of the sweep on one channel he analyser returns to thehold
state, then the sweep initiation for another channel is available.

5.2 External Trigger

If trigger source is set to the Externalby the command TRIG:SOUR EXT, the
sweepstarts at sigral arrival on the external trigger input.

At the moment of a trigger signal arrival the Analyzer must be in the trigger
waiting state, otherwise the signal is ignored but no error is detected.

As a rule the hardware trigger output is used to degrmine the end of the sweep.
If there is a need to determine programmatically the end of the sweep, the
TRIG:WAIT command can be used. Using programywa determine the end of
the sweep requires thecontinuous initiation modeurned OFF.

Example 3. Starts sweep at the signal on the external trigger input.
Programmatically waits for its completion. Thecontinuous initiation modenust
be turned OFF.

TRIG:SOUR EXT Selects the external trigger source

INIT:CONT OFF Puts channel 1 to the hold state

<loop>:
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INIT Puts channel 1 to thetrigger waitingstate.
The sweep starts at external trigger signal
TRIG:WAITHOLD | Waits for the end of the sweep

*OPC? Any query is required

After completion of the sweep the analyser returns to thehold state, then the
next sweep initiation is available.

5.3 Waiting for Calibration Commands

Depending on the sweep settings the calibration commands may have long
execution time, as they start sweep and wait it completion.These commands
are:

SENS:CORR:COLL:XXXX
SENS:CORR:OFFS:COLL:XXXX
SENS:CORR:REC:COLL:XXXX
SENS:CORR:COLL:ECAL:XXXX
SENS:CORR:COLL:ECAL:ORI:EXEC

The user program can determine the end of these command using any query,
the *OPC? for example.

5.4 VISA Timeout Considerations

When using the query*OPC? for waiting an operation the VISA imeout value
must be set to the value no less than the expected sweep time. For example in
C/C++:

viSetAttribute(instr, VI_ATTR_TMO_VALUE, 5000);

5.5 Receiving Data Arrays in Text Form

By default the data from the analyzer is transmitted in a text form. The MA
library has built-in facilities for receiving an array of data from the analyzer. The
example assumes that the size of the array is sufficient to receive a number of
elements equal to twice the number of points.

An example of receiving a data array irC/C++:

double DataArray[1000];
ViUInt32 retCount;
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5.6 Receiving Data Arrays in Bing Form

The transfer of data from the analyzer in binary form reduces the amount of
data transferred and the transmission time. The transfer of binary data is
supported only by the HiSLIP protocol. To enable binary data transfer, use the
FORM: DATAcommand The list of commands that support the transfer of binary

data is givenin the description of the FORM: DATAcommand.

Binary data is transmitted as a block having a header followed by datdlock
format:

# ’8 <Data Size> |<Binary Data>

Where:
# ¢ the character '#';
8 £ the character '8';

<Data Size>t 8 bytes, the symbolic representation of the number of bytes of
binary data.

For example:
#800003216<Binary Data>
The VISA library has builin tools for receiving binary data from the analyzer.

The example assumes that the size of the array is sufficient to receive a number
of elements equal to twice the number of points.

Example of receiving binary data array in C/C ++:

double DataArray[1000];
ViUInt32 retCount;

;/.i-Printf(instr, "FORM:DATA REAL n");
retCo unt= sizeof (DataArray) / sizeof( double );
viQueryf(instr, "CALC:DATA:FDAT?\ n", "%#Zb", &retCount, DataArray);

/I retCount now contains the actual number of elements read
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